# Table of Contents

## 1. THE BASICS ................................................................................................................................. 7
1.1. About This User's Manual ........................................................................................................... 7
1.2. Cascade Server System Requirements ....................................................................................... 7
1.3. Log In and Out ............................................................................................................................ 7

**To Log In:** ......................................................................................................................................... 7

**To Log Out:** ....................................................................................................................................... 7
1.4. Change Your Password (available for District Admin only) ..................................................... 8
1.5. Online Help .................................................................................................................................. 8
1.6. Bookmark / Share Assets ............................................................................................................ 8
1.7. My Content ................................................................................................................................. 8
1.8. Multiple Sites ............................................................................................................................... 8

### 1.8.1. Change Sites ....................................................................................................................... 8
### 1.8.2. Cross-Site Linking and Asset Sharing .................................................................................. 8

1.9. Top Navigation ........................................................................................................................... 8
1.10. Dashboard / Home Area ........................................................................................................... 9
1.11. Asset Tree .................................................................................................................................. 9

#### 1.11.1. Icon Definitions ................................................................................................................. 9
#### 1.11.2. Open / Close Folders ......................................................................................................... 9
#### 1.11.3. Context Menu .................................................................................................................... 9

1.12. View an Asset ........................................................................................................................... 9
1.13. Asset Action Toolbar ................................................................................................................ 9

## 2. EDIT A PAGE .................................................................................................................................... 10
2.1. Page Titles ................................................................................................................................... 10
2.2. The Content Editor .................................................................................................................... 10

#### 2.2.1. Helpful Tips ....................................................................................................................... 11
#### 2.2.2. Copying & Pasting From an External Source ....................................................................... 11

2.3. Images ....................................................................................................................................... 11

#### 2.3.1. Internal ............................................................................................................................. 11
#### 2.3.2. External ............................................................................................................................ 12

#### 2.3.3. Upload an Image within the Content Editor .................................................................... 13
#### 2.3.4. Inserting an Image with a Caption .................................................................................. 13

2.4. Links .......................................................................................................................................... 14

#### 2.4.1. Link to Page or File ........................................................................................................... 14
#### 2.4.2. Link to External Web Site .................................................................................................. 14
#### 2.4.3. Link to Email Address ...................................................................................................... 15
#### 2.4.4. Anchor Links .................................................................................................................... 15

2.5. HTML Editing ........................................................................................................................... 16
2.6. Embed JavaScript Snippets or Audio/Video ............................................................................ 16

#### 2.6.1. JavaScript Snippets ........................................................................................................... 16
#### 2.6.2. Audio / Video ...................................................................................................................... 16

2.7. Tables ........................................................................................................................................ 17
2.8. Advanced Options .................................................................................................................... 18
2.9. Metadata ..................................................................................................................................... 18
2.10. System Information .................................................................................................................. 18
2.11. Version Comments ................................................................................................................... 19
2.12. Save Your Page ....................................................................................................................... 19

#### 2.12.1. Save as Draft ................................................................................................................... 19
#### 2.12.2. Save as a Final Version .................................................................................................. 20

## 3. PUBLISHING .................................................................................................................................... 21
3.1. Publish a Single Asset ................................................................. 21
3.2. Publish Multiple Assets ............................................................. 21
3.3. Publish a Folder ........................................................................ 22
3.4. Publish Your Full Site (for admins only) ...................................... 22
3.5. Un-publish an Asset .................................................................. 22
3.6. Publishing Related Pages ............................................................ 22
3.7. Publishing Guidelines ................................................................. 23
4. CREATE A PAGE ............................................................................ 24
5. SUBSECTIONS (colleges only) ......................................................... 25
  5.1. Add a Subsection ..................................................................... 25
  5.2. Edit a Subsection ..................................................................... 26
6. FOLDERS ......................................................................................... 26
  6.1. Add a Folder ............................................................................ 26
  6.2. Edit a Folder ............................................................................ 27
7. ASSET (FILE) MANAGEMENT .......................................................... 27
  7.1. Uploading Files ....................................................................... 27
  7.1.1. Upload a Single File ............................................................... 27
  7.1.2. Upload Multiple Files ............................................................ 28
  7.1.3. Update an Existing File ........................................................ 29
  7.2. Edit an Image ......................................................................... 29
  7.3. Copy Assets ........................................................................... 31
  7.3.1. Copy a Single Asset ............................................................... 31
  7.3.2. Copy Multiple Assets ............................................................ 31
  7.4. Move Assets .......................................................................... 32
  7.4.1. Move a Single Asset ............................................................... 32
  7.4.2. Move Multiple Assets ............................................................ 33
  7.5. Delete Assets ......................................................................... 33
  7.5.1. Delete a Single Asset .............................................................. 33
  7.5.2. Delete Multiple Assets ............................................................ 34
  7.6. Rename an Asset .................................................................... 34
  7.7. Deactivate / Activate an Asset ................................................... 35
  7.7.1. Deactivate an Asset ............................................................... 35
  7.7.2. Activate an Asset ................................................................. 35
8. MANAGE NAVIGATION AREAS ....................................................... 35
  8.1. Add an External Link ................................................................ 35
  8.1.1. Internal Reference link (District or Intranet website only) ....... 35
  8.1.2. External link (all sites) .......................................................... 36
  8.2. Sort Links ............................................................................ 36
  8.3. Remove a Link ......................................................................... 37
9. VERSIONS ...................................................................................... 37
  9.1. Restore a Previous Version ........................................................ 37
  9.2. Delete Versions ....................................................................... 38
10. MISCELLANEOUS FEATURES ........................................................ 38
  10.1. Recycle Bin - Trash ................................................................. 38
  10.2. Stale Content Reporting .......................................................... 39
    10.2.1. Summary Report ............................................................... 39
    10.2.2. Detailed Report ................................................................. 39
11. USABILITY GUIDELINES ............................................................... 39
# COMMON PAGE FEATURES

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.1.</td>
<td>Metadata</td>
</tr>
<tr>
<td>12.2.</td>
<td>Asset Search</td>
</tr>
<tr>
<td>12.3.</td>
<td>Choose a File or Page</td>
</tr>
<tr>
<td>12.4.</td>
<td>Links</td>
</tr>
<tr>
<td>12.5.</td>
<td>Date / Time</td>
</tr>
<tr>
<td>12.6.</td>
<td>Groups</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.6.1.</td>
<td>Expand / Collapse</td>
</tr>
<tr>
<td>12.6.2.</td>
<td>Add / Remove / Sort</td>
</tr>
</tbody>
</table>

# STANDARD PAGE

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>13.1.</td>
<td>Impact Image</td>
</tr>
<tr>
<td>13.2.</td>
<td>Left Column</td>
</tr>
<tr>
<td>13.2.1.</td>
<td>Calls to Action</td>
</tr>
<tr>
<td>13.2.2.</td>
<td>Contact Information</td>
</tr>
<tr>
<td>13.3.</td>
<td>Content Area</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>13.3.1.</td>
<td>Main Title</td>
</tr>
<tr>
<td>13.3.2.</td>
<td>Main Content</td>
</tr>
<tr>
<td>13.3.3.</td>
<td>Content Area Widgets (colleges only)</td>
</tr>
</tbody>
</table>

| 13.4.   | Google Map |

| 13.4.1. | Find Location’s Longitude and Latitude Coordinates |
| 13.4.2. | Add / Edit a Location |

| 13.5.   | Supplemental Content |

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>13.5.1.</td>
<td>Buckets</td>
</tr>
<tr>
<td>13.5.2.</td>
<td>Accordion</td>
</tr>
</tbody>
</table>

| 13.6.   | Right Column |
| 13.7.   | Last Updated Date |

# WIDGETS

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.1.</td>
<td>Create a Widget (colleges only)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.1.1.</td>
<td>Content</td>
</tr>
<tr>
<td>14.1.2.</td>
<td>Events</td>
</tr>
<tr>
<td>14.1.3.</td>
<td>Faculty</td>
</tr>
<tr>
<td>14.1.4.</td>
<td>Image</td>
</tr>
<tr>
<td>14.1.5.</td>
<td>Links</td>
</tr>
<tr>
<td>14.1.6.</td>
<td>RSS</td>
</tr>
<tr>
<td>14.1.7.</td>
<td>Video</td>
</tr>
</tbody>
</table>

| 14.2.   | Edit a Widget |
| 14.3.   | Delete a Widget |

# PHOTO GALLERY

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
</table>

# DOCUMENT DIRECTORY (colleges only)

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>16.1.</td>
<td>Tagging Files</td>
</tr>
<tr>
<td>16.2.</td>
<td>Add a Document Listing Page</td>
</tr>
</tbody>
</table>

# HOMEPAGE (ADMINISTRATORS ONLY)

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>17.1.</td>
<td>Media (Slideshow)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>17.1.1.</td>
<td>Button</td>
</tr>
<tr>
<td>17.1.2.</td>
<td>Slideshow</td>
</tr>
</tbody>
</table>

| 17.2.   | News |
| 17.3.   | Callouts |

# PEOPLE SITES (ADMINISTRATORS for Colleges ONLY)

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>18.1.</td>
<td>Add a People Site</td>
</tr>
</tbody>
</table>

Beacon Technologies, Inc
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>18.2. Edit a People Site</td>
<td>54</td>
</tr>
<tr>
<td>18.3. Delete a People Site</td>
<td>54</td>
</tr>
<tr>
<td>19. DEPARTMENT PAGES (colleges only)</td>
<td>54</td>
</tr>
<tr>
<td>19.1. Department Landing page</td>
<td>54</td>
</tr>
<tr>
<td>19.2. Department Listing page</td>
<td>55</td>
</tr>
<tr>
<td>19.3. Dropdown Menus</td>
<td>55</td>
</tr>
<tr>
<td>19.3.1. Add an Item</td>
<td>55</td>
</tr>
<tr>
<td>19.3.2. Edit / Delete an Item</td>
<td>55</td>
</tr>
<tr>
<td>20. CALENDAR (ADMINISTRATORS ONLY)</td>
<td>56</td>
</tr>
<tr>
<td>20.1. Definitions</td>
<td>56</td>
</tr>
<tr>
<td>20.2. Add an Event in Cascade</td>
<td>56</td>
</tr>
<tr>
<td>20.2.1. Publishing New Events</td>
<td>57</td>
</tr>
<tr>
<td>20.2.2. Edit an Event</td>
<td>58</td>
</tr>
<tr>
<td>20.2.3. Delete an Event</td>
<td>58</td>
</tr>
<tr>
<td>20.3. Add a Year Folder</td>
<td>58</td>
</tr>
<tr>
<td>20.4. Public Event Submission</td>
<td>59</td>
</tr>
<tr>
<td>20.4.1. Edit Event Posting via Workflow</td>
<td>59</td>
</tr>
<tr>
<td>20.4.2. Publish Event Posting via Workflow</td>
<td>60</td>
</tr>
<tr>
<td>20.4.3. Delete Event Posting via Workflow</td>
<td>60</td>
</tr>
<tr>
<td>20.5. Calendar Grid Pages</td>
<td>61</td>
</tr>
<tr>
<td>20.6. Filters on Grid Pages</td>
<td>61</td>
</tr>
<tr>
<td>20.6.1. Update the Color Mapping for Grid Page</td>
<td>61</td>
</tr>
<tr>
<td>20.7. Printable Calendars</td>
<td>61</td>
</tr>
<tr>
<td>20.8. Event Widgets (colleges only)</td>
<td>61</td>
</tr>
<tr>
<td>20.9. Home Page Calendar Events</td>
<td>62</td>
</tr>
<tr>
<td>20.10. Updating Category List</td>
<td>62</td>
</tr>
<tr>
<td>20.11. Unused Base Features</td>
<td>63</td>
</tr>
<tr>
<td>20.12. Additional Calendar Information</td>
<td>63</td>
</tr>
<tr>
<td>21. NEWSLETTER ARCHIVE (ADMINISTRATORS ONLY)</td>
<td>64</td>
</tr>
<tr>
<td>22. EMERGENCY MESSAGE (ADMINISTRATORS – Colleges ONLY)</td>
<td>64</td>
</tr>
<tr>
<td>23. EMERGENCY MESSAGE (ADMINISTRATORS – District ONLY)</td>
<td>64</td>
</tr>
<tr>
<td>24. SITE MAP (ADMINISTRATORS ONLY)</td>
<td>65</td>
</tr>
<tr>
<td>25. TOP NAVIGATION AND FOOTER (ADMINISTRATORS – colleges ONLY)</td>
<td>65</td>
</tr>
<tr>
<td>25.1. Top Navigation (Mega Menu)</td>
<td>65</td>
</tr>
<tr>
<td>25.2. Footer</td>
<td>66</td>
</tr>
<tr>
<td>26. REDIRECTS AND VANITY URLS (colleges only)</td>
<td>66</td>
</tr>
<tr>
<td>26.1. Redirects</td>
<td>66</td>
</tr>
<tr>
<td>26.1.1. Add a Redirect</td>
<td>66</td>
</tr>
<tr>
<td>26.1.2. Remove a Redirect</td>
<td>67</td>
</tr>
<tr>
<td>26.2. Vanity URLs</td>
<td>67</td>
</tr>
<tr>
<td>26.2.1. Add a Vanity URL</td>
<td>67</td>
</tr>
<tr>
<td>26.2.2. Remove a Vanity URL</td>
<td>68</td>
</tr>
</tbody>
</table>
## 2. Revision History

<table>
<thead>
<tr>
<th>Name</th>
<th>Date</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>J. Klingman</td>
<td>08/29</td>
<td>Original Version (1.0) Beacon Technologies</td>
</tr>
<tr>
<td>J. Klingman</td>
<td>09/19</td>
<td>Corrected errors identified in training session</td>
</tr>
<tr>
<td>J. Klingman</td>
<td>10/19</td>
<td>Updates in preparation for Administration training</td>
</tr>
<tr>
<td>J. Klingman</td>
<td>10/30/</td>
<td>Updates after Administration training</td>
</tr>
<tr>
<td>J. Klingman</td>
<td>11/18/</td>
<td>Added Section 24, “Redirects”</td>
</tr>
<tr>
<td>A. Fowler</td>
<td>12/15/</td>
<td>Added Section 19, “Department Pages” and Section 20.7, “Additional Calendar Info”, and Accessibility info to tables in section 2.7</td>
</tr>
<tr>
<td>A. Fowler</td>
<td>1/26/</td>
<td>Added calendar information</td>
</tr>
<tr>
<td>D. Smith (GCCCD)</td>
<td>June</td>
<td>Revised for Cascade 8</td>
</tr>
</tbody>
</table>
1. **THE BASICS**

1.1. **About This User’s Manual**

This manual is organized to provide you with helpful information about using the software. In order to provide our clients with the most helpful information, only relevant topics are covered in this manual. If you have a question about any feature not covered in this manual, please do not hesitate to contact us. This manual assumes that:

- You have a basic understanding of your computing environment and that you are familiar with common file options such as open, close, and save files.
- You are able to use the Internet and have experience using a web browser.
- Also, it is assumed that the user is knowledgeable in basic image formatting for use on the Web.
- The user has a good understanding of Microsoft Word© and its functions.

1.2. **Cascade Server System Requirements**

You can access Cascade Server to update your site from anywhere you have access to the Internet. Your computer will need to meet or exceed the following software requirements:

- **Web Browser:**
  - Google Chrome (preferred)
  - Mozilla Firefox
  - Apple Safari
  - Microsoft Internet Explorer 11+
- Screen resolution of 1024 x 768 or higher
- Pop-up Blockers: Cascade Server relies heavily on the use of pop-up windows. You will need to configure your pop-up blocker to allow all pop-ups from this site ([http://cms.gcccd.edu/](http://cms.gcccd.edu/)).

1.3. **Log In and Out**

Each person using the software needs a username and password to access the system. For security purposes, inactive users will automatically be logged off after a period of time. Users should log off when not using the system.

**To Log In:**

1. In your browser, go to the URL received from your administrator (add this address to your Favorites or Bookmarks).
2. Enter your **Username** and your **Password**.
3. If you wish for the system to automatically log you in next time, check **Remember me** just below the “Log in to Cascade Server button. The system will remember your login for two weeks, or until you click **Log Out**.
4. Click **Log in to Cascade Server**.

**To Log Out:**

Select the **Sign Out** link from the drop down menu of the profile initial in the upper right-hand corner.
1.4. **Change Your Password (available for District Admin only)**

1. From the drop down menu of the profile initial upper right-hand corner navigation, click **Settings**.

2. In the “Change Password” section, type in your new password (twice), and then click **Submit**.
   - **NOTE:** Your password is case-sensitive. There are no restrictions on length or types of characters used.

1.5. **Online Help**

At any time, you may access the Online Help section by clicking on the “Help & Support” link from the menu in the upper right-hand corner.

   - **NOTE:** This online help is provided by Hannon Hill, and not Beacon Technologies.

1.6. **Bookmark / Share Assets**

Cascade Server allows you to bookmark any asset in your browser for easy editing. Just navigate to the desired asset, and bookmark that page. You can also email the URL of an asset. This is useful if you would like another colleague to review a page within Cascade Server. Simply copy the URL of the desired asset and paste into an email. Please note that the recipient will be required to log into Cascade Server in order to view the asset.

1.7. **My Content**

A menu containing links to frequently-used tools in Cascade Server can be found in the upper right-hand corner menu by clicking on **My Content**. A menu will pull down containing links to Dashboard items (see Section 1.10) and your recent history (for the current session only).

1.8. **Multiple Sites**

   - **NOTE:** This section is only applicable to users who have access to two or more sites in Cascade Server.

   1.8.1. **Change Sites**

You can switch sites by using the Site Selection Menu at the top of the screen.

1.8.2. **Cross-Site Linking and Asset Sharing**

With multiple sites in Cascade Server, you can create links between sites, as well as call (share) assets from other sites. When inserting an image or link, use the Site Selection Menu at the top of the asset selection popup window to select an asset from another site. Inserting images and links will be covered in Section 2.3.

1.9. **Top Navigation**

The top navigation is in the black area at the top of your browser: Site Selection, Profile, and Cascade 8 menus. After selecting a site, you will also have access to the +Add Content menu. To navigate the top navigation menu sections, click on the item. A drop down menu of options for that section will appear. You must then select the appropriate option. Each menu option will be covered in later sections of this manual.
1.10. Dashboard / Home Area

Upon logging in, every user is greeted with a personalized dashboard showing messages, current workflows, assets checked out, and much more general information. The Dashboard is used to supply the user with a summary of the activities that require user attention. The dashboard can be accessed at any time by selecting the Dashboard icon in the upper left-hand corner.

The Dashboard can be customized by clicking on the +Add Widget button and selecting additional items.

1.11. Asset Tree

All of your folders, pages, and files are located in the left column asset tree, which is similar to Windows Explorer.

1.11.1. Icon Definitions

Each icon represents a different kind of asset in Cascade Server, defined below:

- folder
- external-link
- file.pdf
- page

1.11.2. Open / Close Folders

There are two ways to open and close folders:
- Click on the arrow corresponding to the folder to fully open the folder and view details in the right column.
- Click on the folder icon or name to open or close the folder.

1.11.3. Context Menu

Each asset in the asset tree has a menu containing common actions for that type of asset, such as Edit, Publish, etc. To view the Context Menu for an asset, simply right-click the asset, and then click on the desired action for that asset.

1.12. View an Asset

In order to browse your site, simply click on the desired folder on the left side to expand the folder tree. Once the folder expands, the sub-folders and assets are displayed in the same directory structure that exists when published. Clicking on a page in the folder such as the default page will bring up a preview of that page in the right frame, just as it would appear online.

1.13. Asset Action Toolbar

The Asset Action Toolbar is displayed when viewing an asset. Each relevant function will be covered in more detail later. Some actions are available from the ‘…More’ button.

View:
- Shows the design view of the page.
- Full Screen Preview: Shows the page as it will look once published.
- Live: Shows the corresponding page on your live Web site. Clicking this link allows you to view a page that you just published without having to leave Cascade Server.
- Details: Shows information for the current page.
Edit: Start editing the page’s content and metadata. Clicking this will start the editor. See Section 2.
- Content: The area where you edit your content and inline metadata.
- Metadata: Edits additional search engine metadata.
- Configure: Toggle whether this asset should be published or indexed; view the template and regions used.

Move/Rename: Move this asset to another folder, or change the name of this asset. See Section 7.4.

Copy: Copies the current page and its contents to a specified location. See Section 7.3.

Publish: Used to move your pages out to your Web site. See Section 3.

More: Clicking this will show a drop-down menu containing more options. The most notable is “Delete” (Section 7.5) and “Versions” (Section 9), which allows a user to restore a previous version of the current asset.

2. Edit a Page

When editing a page, you can edit your content, change the name of a page, change page titles, and maintain metadata keywords and descriptions for search engines. You can create links to internal pages and external sites, insert images, create tables, and much more.

To edit a page, click on the desired page in the left Asset Tree, and then click the Edit button in the Asset Action Toolbar.

2.1. Page Titles

This feature gives you the ability to control the titles of a page, both what is displayed in the content area, and what is displayed in the site’s navigation.

The Display Name and Title fields are located at the top of the page when in Edit. There are two fields for maintaining this information:

- Display Name (colleges): The page’s title that is displayed in your left navigation and in the breadcrumbs.
- Title (colleges): The title that is displayed in the page’s title tag (<title>).
- Title (District/Intranet): The title that is displayed in the page’s title tag (<title>), and the page’s title that is displayed in your left navigation and in the breadcrumbs.
- Main Title: The page’s title that appears at the top of the main content area.

2.2. The Content Editor

The content editor integrated into Cascade Server has the same functionality and features you are most likely accustomed to using in a standard editor, such as Microsoft Word®. The advanced features of the editor are explained in the next Sections. Mouse over each icon in the editor toolbar to see its description.

To insert/edit content, simply type in your text, or paste from an external source, just as you would in a standard word processor.
2.2.1. **Helpful Tips**

- Press the “Enter” key for a double-spaced line. To make a single-spaced line, hold “Shift” while pressing Enter.
- You can open the editor in full screen mode to make it easier to edit large amounts of content. To do this, click the “Full Screen” button. To close the full screen mode, click the button again.

2.2.2. **Copying & Pasting From an External Source**

If you copy and paste your text from an external source (such as Microsoft Word), Cascade Server will attempt to clean up the source document’s formatting in order to display your content in your Web site’s default font. If this does not work properly, select all text in the editor, and then click the “Format, Clear Formatting” option.

Doing so should remove any undesired formatting copied over from your source document. This will allow your site to maintain a consistent font type, size, and color.

As a last resort, before pasting your content into the editor, click the “Edit, Paste as Text” option in the toolbar, and then paste. This will bring in all of your content in plain text with no formatting.

2.3. **Images**

You can either insert an image that has been uploaded into Cascade Server, or point to an image that exists on another Web site. Also in this Section, you can upload an image while editing the page.

**NOTES:**

- The maximum width for any image inserted into the editor is **375 (3-column page) or 645 (2-column page) pixels**. There is no restriction on height.
- For best results, any image that is used in your content should be properly sized before inserting into your content area. You can upload and edit an image using Cascade Server’s image editor. See Section 3 below.
- For advanced image editing not covered by the Cascade Server image editor, use a graphics program before uploading the image into Cascade Server.
- To insert an image into the editor with a caption, see Section 2.3.4 below.

2.3.1. **Internal**

An “Internal” image is defined as an image that already resides in Cascade Server. This means that any image you want to insert into your content must first be uploaded into Cascade Server. Once your image is in Cascade Server, follow the instructions below to insert the image into your content.

1. Place your mouse cursor in your content where you want the image to appear.
2. Click on the **Insert/edit Image** icon in the toolbar. A pop-up window will appear.
3. In the “Image” field, select the image you want to display by doing the following.
   **NOTE:** If the image you want to use is not in Cascade Server, you can upload it now by using the steps in Section 2.3.3.
a) Click “Choose File, Browse”. Another window will open, and you will see your folder tree. Proceed to Step b below. Alternatively, click “Choose File, Browse”, and either type in the name of the asset to search for it, or select an asset from the displayed history (if applicable). Once your asset is selected, skip to Step c.

b) Click on the appropriate folders until you find the folder which contains your image, and click on that image to select it. A preview of the image will appear on the right side of the window.

c) Click Choose. The window will close, and the “Image” field will be populated in with the selected image’s path.

4. The “Alternate Text” field is the text that will display when a user mouses over the image (also known as the “ALT Tag”). This is also necessary for screen readers used by the visually impaired. Type in a short, meaningful description for the image. **NOTE:** This field is required.

5. **Do not enter any values for Width/Height.** We recommend resizing your image using the instructions in Section 3 below, and **not** using these fields.

6. There are several advanced attributes for an image. Click on the **Advanced** tab at the top of the window:

   - **Figure/Caption:** Adds a Caption to the image.
   - **Border:** Places a border around your image. **NOTE:** We recommend adding a border to your image with a graphics program, and **not** using this field.
   - **Vertical Space:** The number of pixels of padding around the top and bottom of your image. **NOTE:** We recommend using a value of at least “5” for best usability practices.
   - **Horizontal Space:** The number of pixels of padding around the left and right of your image. **NOTE:** We recommend using a value of at least “5” for best usability practices.

7. Click the **OK** button. The window will close, and your image will be inserted into the content.

8. If you need to modify your image, click on your image, and then click on the **Insert/edit Image** icon in the toolbar again. To move your image, click and drag the image to the desired location.

2.3.2. **External**

An “External” image is defined as an image that exists on another Web site. This means that every time someone views your Web page, the image will be called from the specified external Web site.

To link to an external image, you will need the full Web address (URL) for the image. Then do the following:

1. Place your mouse cursor in the area desired for the image within your content.

2. Click on the **Insert/edit Image** icon in the toolbar. A pop-up window will appear.

3. At the top of the popup window, select the **External** radio button.

4. In the “Image” field, type the exact Web address (URL) of the image you wish to link to. For example,
enter:

http://www.beaconstechnologies.com/images/logo.gif

⚠️ NOTE: Ensure that your link starts with http:// or https://. Otherwise, the image will be broken.

5. Follow Steps 4-8 in Section 2.3.1 above.

2.3.3. Upload an Image within the Content Editor

If your desired image is not loaded into Cascade Server, you can upload the image by doing the following from the Insert/Edit Image dialog box:

1. Follow the instructions in Steps 1-2 in Section 2.3.1 above.

2. In the “Image” field, click “Choose File”. Another window will open, and you will see your folder tree.

3. Click on Upload in the top bar.

4. Drop a file here or click inside the file drop area to locate the image file on your hard drive or network drive.

5. Click Open. Your image will be uploaded into the system and the filename displayed. You can change the File Name.

6. In the folder tree below, click on the folder you wish to upload the image into.

7. Click Choose to select the uploaded image. The window will close, and your image will be listed in the “Image” field.

8. Follow Steps 4-8 in Section 2.3.1 above.

⚠️ NOTE: You can also upload an image using Section 7.1.3 below.

2.3.4. Inserting an Image with a Caption

If you want to insert an image into your content area and display a caption below the image, you will need to select the Advanced tab in the Insert/edit image screen. Check the box for Use figure and figcaption for this image. You may want to add Vertical and Horizontal space to the image (5 is a good number). Click OK to insert your image with a caption. In the lower area of your image is a field for the caption. Click in this field to edit the caption.
2.4. Links

You have the ability to make text or an image link to a page, a file (PDF, etc.), or an external Web site. Also, you can link to a person’s email address, or add an anchor link in order to jump to a Section within your page.

2.4.1. Link to Page or File

This Section explains how to link to a page or a file that already resides in Cascade Server.

- To create a page, see Section 4.
- To upload a file, see Section 7.1.

1. Highlight the word(s) or click on the image you wish to make a link, and then click the Insert/edit Link icon in the toolbar. A pop-up window will appear.

2. In the “Link” field, select the page or image you want to link to by doing the following:
   a) Click in the “Choose File, Page, or Link” field. Another window will open, and you will see your folder tree.
   b) If necessary, select the “Browse” link. Click on the appropriate folders until you find the folder which contains your asset, and click on that asset (page or file) to select it. The path to the selected asset will appear underneath the asset. Alternatively, click in the “Search” field and type in the name of the asset to search for it, or select an asset from the displayed Recent history (if applicable).
   c) Click Choose. The window will close, and the “Link” field will be populated in with the selected asset. The path will display underneath the “Link” field.

3. If you want to link to a pre-defined anchor point within the selected page, enter the anchor’s name into the “Anchor” field. See Section 2.4.4 below to create anchor points.

4. Set the “Target” field as follows:
   • When linking to a page or file you want to open in the same window: “None”
   • When linking to a page or file you want to open in a new window: “New Window”

5. Click OK. The window will close, and your text (or image) will now be a link to the selected asset.
   !NOTE: The text or image will not be clickable within the content editor.

6. If you need to modify your link, click on your link text or the image and click the Insert/edit Link icon in the toolbar. If you wish to remove a link, click on your link text or the image, and then click the Unlink icon in the toolbar.

2.4.2. Link to External Web Site

This Section explains how to link to another Web site.

!NOTE: To link to another Web site, you will need the full Web address (URL) for the site.

1. Highlight the word(s) or click on the image you wish to make a link, and then click the Insert/edit Link icon in the toolbar. A pop-up window will appear.
2. Click the External radio button at the top of the window.

3. In the “Link” field, type in the Web address of the site you wish to link to (e.g. https://www.beacontechnologies.com/
   ❚NOTE: Your link must start with http:// or https://. Otherwise, the link will be broken.

4. Set the “Target” field to New Window.

5. Click OK. The window will close, and your text (or image) will now be a link.
   ❚NOTE: The text or image will not be clickable within the content editor.

6. If you need to modify your link, click on your link text or the image and click the Insert/edit Link icon in the toolbar. If you wish to remove a link, click on your link text or the image, and then click the Unlink icon in the toolbar.

2.4.3. Link to Email Address

This option makes your link open the user’s default mail program in order to send an email to the specified e-mail address. If you want to simply display the recipient’s email address as the link text, just type their email address into the editor, and add a period or a space after it. Otherwise, follow the instructions below.

1. Highlight the word(s), or click on the image you wish to link to an email address, and then click the Insert/edit Link icon on the toolbar.

2. Click the External radio button at the top of the window.

3. In the “Link” field, remove the “http://” that is in the field by default. Then type “mailto:” and then the email address you wish to link to (e.g. pcs@beacontechnologies.com). The field should look like this:

   mailto:pcs@beacontechnologies.com

4. Click OK. The window will close, and your text (or image) will now be a link.
   ❚NOTE: The text or image will not be clickable within the content editor.

5. If you need to modify your link, click on your link text or the image and click the Insert/edit Link icon in the toolbar. If you wish to remove a link, click on your link text or the image, and then click the Unlink icon in the toolbar.

2.4.4. Anchor Links

This option allows you to link to a specified point within the current page, or on another page. For instance, if you would like to create a link that “jumps” the user down to another part of your page, do the following:

1. Place your cursor in the content where you wish to make the anchor point (the place where you want the user to “jump” to), and then click the Anchor icon.
2. Type the name of your anchor into the “Anchor Name” field. For example, if you are linking to a Section called “History”, name your anchor “history”. ▶️NOTE: Do not put any spaces in your anchor name. Take note of the exact value you are typing in here, which will be used in a later step.

3. Click OK. The editor places an anchor icon 📖 indicating that you have added an anchor.

   ▶️NOTE: This icon will not be displayed when published.

4. Highlight the text or click on the image that you wish to link to the anchor that you just created in Step 3, and then click the Insert/edit link icon 📖.

5. If you are linking from another page to this anchor point, select the page you wish to link to in the “Link” field. If you are linking to an anchor point within the current page, skip to Step 6.

6. In the “Anchor” field, type the exact name that you used in Step 2 above.

   ▶️NOTE: This value must match the value from Step 2 exactly, including using the same capitalization.

7. Click OK. The text is now the link to your anchor point.

   ▶️NOTE: The text or image will not be clickable within the content editor.

8. If you need to modify your link, simply click on your link text or the image and click the Insert/edit Link icon 📖 in the toolbar. If you wish to remove a link, click on your link text or the image, and then click the Unlink icon 📖 in the toolbar.

2.5. HTML Editing

To edit the HTML for your content, click on the Source Code icon in the toolbar. A popup window will appear containing the content’s HTML. Make the desired HTML edits, and then click the OK button at the bottom of the window.

2.6. Embed JavaScript Snippets or Audio/Video

   ▶️NOTES:
   - This Section is for advanced users only who are familiar with embedding different types of media into a Web page and modifying an embed statement’s advanced attributes.
   - The maximum width for any media inserted into the editor is 375 (3-column page) or 645 (2-column page) pixels.

2.6.1. JavaScript Snippets

To embed JavaScript into the content editor, use the HTML Editing feature (see Section 2.5 above).

2.6.2. Audio / Video

There are two methods for inserting audio or video into your content:

   Insert/edit media

Located in the content editor’s toolbar, using this allows you to easily add external rich media applications into your content area, such as HTML5 Video tags, Flash applications, MP3 players, and YouTube videos. To use this feature, use the Insert/Edit Media button in the wysiwyg toolbar.
2.7. Tables

There are two methods of inserting a table. An easy way to create an accessible table is to copy one already created and modify it.

Inserting a table into Cascade Server is very similar to Microsoft Word’s insert table wizard:

1. Place your cursor in the desired location of your table, click the Table dropdown arrow, select Table, highlight the number of rows and columns desired, and then click to insert the table. After the Table has been inserted, you can change the Table Properties by clicking within the table, selecting either the popup Table Properties icon OR click the Table dropdown arrow and select Table Properties.

2. To change the Row or Cell Properties, click the Table dropdown arrow and select Row, Row Properties, or Cell, Cell Properties. Type in the desired values.

3. In the “Cellpadding” and “Cellspacing” Sections, type in the desired amount (in pixels). We recommend starting with “3”. **NOTE:** If you are using a preformatted table (Step 7 below), skip this step.

4. Set the alignment of the table in the “Alignment” menu. “None” means you can place the table anywhere on the page, and it will be in-line with your text.

5. Set the desired border thickness of your table, measured in pixels. The recommended value is “1”. **NOTE:** If you are using a preformatted table (Step 7 below), skip this step.

6. Enter the desired width of your table into the “Width” field. This value should be in a percentage (e.g. “100%”). **NOTE:** The maximum width for any table inserted into the editor is **375 (3-column page)** or **645 (2-column page)** pixels.

7. If you would like to have your table to conform to a predetermined table style (if applicable), in the “Format” drop-down, select “Formats”, “Custom”, then a table style. This will give your table a standard appearance that other pages use. **NOTE:** If you select a class, your “Cellpadding”, “Cellspacing”, and “Border” values must “0” (zero).

8. To set additional options for the table, click on the Advanced tab at the top of the window.

   a) In the “Summary” field, type in a description of the table that you are inserting. This is required for Section 508 Compliance (if applicable). For example: “This table contains 2014 donations data.”

   b) If you would like your table’s borders to have a color, click on the chooser icon in the “Border color” field, which will display a selection of colors to choose from. If you have a specific color you would like to use, simply enter the hexadecimal value in the “Border color” field (e.g. #336699). **NOTE:** If you selected a class in Section 2.7 above, Step #7, do not set a value in this field.

   c) If you would like your table to have a background color, click on the chooser icon in the “Background color” field, which will display a selection of colors to choose from. If you have a specific color you would like to use, simply enter the hexadecimal value in the “Background color” field (e.g. #336699). **NOTE:** If you selected a class in Section 2.7 above, Step #7, do not set a value in this field.
9. Click the **OK** button. This will close the window and display the table within your content.

10. **Table Header:** To create a table header for accessibility purposes, after inserting the table, right click on the correct table row and select **Row, Row Properties.** Then select “Header” from the “Row Type” drop down menu and then hit “Update”.

11. **Column/row scope:** Scope: To add table scope for accessibility purposes, after inserting the table, right-click on the desired cell (either the first cell in the column, or the first cell in the row, depending on the direction of your data), and select **Cell > Table Cell Properties.** In the “Scope” field, select the appropriate value: “Column” or “Row”.

⚠️ **NOTES:**
- **Edit a Table:** To edit your table, right-click anywhere in the table, and select **Table Properties.**
- **Rows and Columns:** To insert or remove columns and rows, or format individual cells, columns, or rows, right-click in the desired column/row/cell to bring up the Table action menu, and select the desired action.

2.8. **Advanced Options**

The options are explained below:

- **Check Spelling:** Cascade Server will check the spelling of your content when you save the page.
- **Check Accessibility:** Cascade Server will verify that your content is Section 508 compliant. This ensures that the web content adheres to government standards for content accessibility for persons with disabilities.
- **Broken Links:** Cascade Server will check the links on your page to ensure that they are all valid.

2.9. **Metadata**

The “Metadata” Section is where you will be able to maintain a page’s Meta Keywords and Description.

To edit a page’s metadata:
1. While editing your page, click on the **Content** button at the top of the edit window.
2. Enter the desired Keywords and Description into the provided fields.
3. Additional Metadata can be entered if you click on the **Metadata** button.

2.10. **System Information**

The **Configure** information of a page allows you to specify whether or not the file should be published or indexed. The relevant options are listed below. While editing your page, click the **Configure** button in the Toolbar.

- **Content Type:** This field should not be changed.
- **Maintain absolute links when rewriting:** This field should not be changed.
- **Include when Publishing:** This will indicate whether your file should publish to your Web site. Uncheck this box to prevent this file from being published. There is rarely a time where you would want to uncheck this box.
• **Include when Indexing**: Tells the system whether or not to include this file in the navigation. Unchecking this box will remove this file from all navigational schemes. This is useful if you want to temporarily “turn off” a page and have it not be available to the user, but you want to keep the file in Cascade Server for later use.

### 2.11. Version Comments

You may wish to insert comments here when editing a page. This will aid in tracking your changes for future modifications. For Versions, see Section 8.2 below.

Cascade Server will automatically add comments for you into the “Comment on the changes you made” field when you Submit your edited page. You can also enter your own comments into this field.

### 2.12. Save Your Page

When you are editing a page, Cascade Server automatically saves your changes as you work as a “Draft” (Section 2.12.1). Once you are done with your changes, you then need to-save the page as a final version (Section 2.12.2).

#### 2.12.1. Save as Draft

The “Save as Draft” feature periodically saves a draft of your asset. While your page is in Draft mode:

- Cascade Server automatically saves your changes every 10 seconds.
- You can preview these changes before submitting them by clicking **Save & Preview**.
- You can navigate away from the page and even log out, and your changes will still be saved in Draft mode for when you return. You can return to edit the draft by selecting **Draft view** instead of the **Current page view**.

![Draft view](image)

- You can see all of your current drafts in the **My Content** menu or dashboard widget.
- Multiple users can save drafts of a page, but those users will not be able to edit or publish your current changes. If another user has made changes to the page while you had a draft in-progress, you will receive a warning message. **By continuing your changes, you will overwrite the other user’s changes with your own.** It is recommended that you discard your draft by clicking the **discard this draft and edit the current version** link within the warning message, and then edit the page again.
- You cannot copy, delete, or publish your changes until you **Submit** the final copy using Section 2.12.2 below.
- A draft saves your work, but your changes will not be committed and saved as a final version until you use the “**Submit**” button (Section 2.12.2 below).
a) Preview Your Changes and View Current Version

By selecting the Draft view, you can preview your draft’s changes within the page view.

1. To continue editing your page, click the Edit link.
2. To discard the draft, click the Discard link.

By selecting the Current view, you can see how the page looked before you started your changes.

b) Exit the Page

You can leave the page to view other assets in Cascade Server, or log out of the system:

1. Make sure that your latest changes are saved by clicking the Save and Preview button.
2. You can now safely navigate to another page, or log out of Cascade Server.

c) Continue Editing a Draft

When you navigate back to a page that you have been editing, either after viewing other assets or logging back into Cascade Server, the first view you will see is the “Current” version of the page. To continue editing the page:

1. You can return to edit the draft by selecting Draft view instead of the Current page view.
2. Click the Edit link, and continue making changes.

d) Discard Your Draft

If you want to revert your page back to the original version, follow the instructions below.

⚠️ NOTE: Using this feature will erase all changes made since the last full save of the page.

1. While editing your page, click the Discard draft button.
   ⚠️ NOTE: If you want to discard the draft of a page while viewing the Current page, you will see a notice “A draft of this page was saved hours ago. Do you want to preview the changes, resume editing or discard it?”, click the Discard it link.
2. In the popup confirmation dialog box, click the OK button. Any edits you made since the last full save of the page will be deleted.

2.12.2. Save as a Final Version

When you are completely done with your changes, click the Save and Preview button; you’ll then need to save your page as a final version.

1. Click the Submit button at the top of the page. This will save your page.

⚠️ NOTES:
- This will not publish your page to your Web site. To publish your page, see Section 3 below.
- If you click the Submit button and see an “Overwrite Current Version” warning message, then you or
another user have a different draft of this asset already in-progress. You can either discard your current draft (Section d) above to preserve the original draft, or you click discard the original draft by clicking the Submit button.

3. Publishing

One of the many benefits of Cascade Server is that you can modify your Web site within the tool, and your changes are not reflected on your live Web site until you publish your content. If you are a user with the appropriate permissions, you can publish an individual file, multiple files, an entire folder, or the entire site to your live Web site. Listed below are some general points about how publishing works:

- Publishing sends your assets from Cascade Server and moves them to the specified destination. Once you have published, it will take some time (depending on the amount of files that are publishing) to display on your live site.
- A page will publish any images that are in its content area. However, it will not publish other linked pages.
- Upon publishing, you can view the Publish Queue screen. On this screen, you’ll see the system’s current progress, as well as any jobs currently in the queue. If you leave this screen, you can get back to it by selecting the System menu from the top right corner of the screen, then Publish Queue.
- To see a confirmation message stating whether or not your file published successfully, click your Dashboard icon on the top left of the screen, and view your Messages. The confirmation message will be displayed once the system has finished publishing.
- To publish all assets related to the asset you’re publishing, see Section 5.

3.1. Publish a Single Asset

To publish a single asset (page, file, or folder):

1. In the left asset tree, click on the asset (page, file, or folder) that you want to publish.
2. In the Asset Action Toolbar, select Publish.
3. Leave all options within the Publish screen as-is.
4. Click the Publish button. Your asset will now publish.

3.2. Publish Multiple Assets

⚠️ NOTE: Using this method will not allow you to select which destinations to publish to. You will automatically have to publish to all available destinations (“Test” and “Production”, for example).

1. In the navigation tree on the left, select the folder where the assets are located (click the corresponding arrow next to the folder).
2. In the right hand window, check the boxes next to the assets that you want to publish.
3. At the top of the file list, click the Publish button (it looks like a cloud with a check mark).
4. Click the Confirm Publish button.
3.3. Publish a Folder

Publishing a folder will publish all assets within that folder, including subfolders.

1. In the navigation tree on the left, select the folder you want to publish.

2. In the Asset Action Toolbar, select **Publish**.

3. Leave all options within the **Publish** screen as-is.

4. Click the **Publish** button. Your folder will now publish.

3.4. Publish Your Full Site (for admins only)

1. In the navigation tree on the left, select the "Base Folder" folder.

2. In the Asset Action Toolbar, select **Publish**.

3. In the “Destinations” Section, choose which Web sites you want publish to by checking/unchecking the appropriate destination(s).

⚠️ NOTES:
- By default, all of your available destinations will be selected.
- For each destination (Test and Production), depending on what type of asset you are publishing, you may see multiple checkboxes for each destination. In order to publish properly, you must select all available checkboxes for the desired destination.

4. Click the **Publish** button. Your site will now publish.

3.5. Un-publish an Asset

With Cascade Server, you have the ability to “un-publish” any asset. Un-publishing will delete an asset from your Web site, but will not remove the file from Cascade Server. To delete an asset from Cascade Server, see Section 1.ab) below.

To un-publish an asset:

1. Choose the desired method of publishing above (single asset, multiple assets, or a folder), and click the …More link.

2. In the …More menu, select **Unpublish**.

3. Leave all options within the **Unpublish** screen as-is.

4. Click **Submit**. The asset will now be un-published.

3.6. Publishing Related Pages

When updating an asset, there may be other assets that you need to publish in order to complete your update. For example, if you rename a page, you not only need to publish the page you renamed, but also any pages that
have links to that page. Cascade Server allows you to view those related assets and publish them. To know whether this Section applies to your changes, see Section 3.7.

**NOTE:** This Section does not apply to navigation updates. If you do something to affect the navigation, you must follow the guidelines in Section 3.7.

1. While viewing an asset, click the **...More** menu, **Relationships** in the Asset Action Toolbar. A listing of all related assets will appear. Note that, while many different types of assets can be displayed in this list, only pages can be published.

2. Select one, many, or all pages to be published by doing one of the following:
   a) **Publish a Single Page** or **selected Multiple Pages**: Using the checkboxes to the left of the pages’ paths, select the ones that you want to publish. At the top of the file list, click the **Publish** button (it looks like a cloud with a check mark). Click the **Confirm Publish** button.
   b) **Publish All Pages** (recommended): To publish all related pages, click the **Publish all** button at the top of the list.

### 3.7. Publishing Guidelines

Knowing what you need to publish in order for your site to maintain its structure is critical. You can continue to have a high-quality Web site by using the guidelines listed below. Exceptions to these guidelines for your specific Web site will be covered with you by a Beacon representative. The below table highlights common changes you will make, and what publishing action you should take.

<table>
<thead>
<tr>
<th>Asset Action</th>
<th>Explanation</th>
<th>Publishing Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Content Changes to a Page</td>
<td>The changes you made only affect the current page.</td>
<td>• Publish Single Asset (Section 3.1)</td>
</tr>
<tr>
<td>• Change a Page’s Metadata</td>
<td></td>
<td>• Publish all affected pages:</td>
</tr>
<tr>
<td>• Add a Page, Subsection, or Navigation Link</td>
<td></td>
<td>o Folder (Section 3.3)</td>
</tr>
<tr>
<td>• Rename a Page, Subsection, or Navigation Link</td>
<td></td>
<td>o Related Pages (Section 5)</td>
</tr>
<tr>
<td>• Move a Page, Subsection, or Navigation Link</td>
<td></td>
<td>o Site Map (Section 3.1)</td>
</tr>
<tr>
<td>• Delete a Page, Subsection, or Navigation Link</td>
<td></td>
<td>o Top Navigation (Section 22.2)</td>
</tr>
<tr>
<td>• Change a Page, Subsection, or Navigation Link Display Name or Title</td>
<td></td>
<td>-- OR --</td>
</tr>
<tr>
<td>• Sort Links in Navigation</td>
<td></td>
<td>• Full Site (Section 4)</td>
</tr>
<tr>
<td>• Upload File(s)</td>
<td>The changes you made only affect the current file(s).</td>
<td>• Publish Single Asset (Section 3.1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-- OR --</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Publish Folder (Section 3.3)</td>
</tr>
<tr>
<td>• Move/Rename/Delete a File</td>
<td>Any link to this file has changed.</td>
<td>• Publish Related Pages (Section 5)</td>
</tr>
</tbody>
</table>
4. **Create a Page**

Creating a new page in Cascade Server is simple. When you add a new page to a main folder (i.e. a folder that is listed as a main category on your Web site), the navigational structure of your site will be automatically updated with the information you provide.

To add a new page:

1. In the left asset tree, click on the folder that you wish to add a new page to.

2. In the Top Navigation Menu bar, click +Add Content, and then locate and click the type of page you wish to add (e.g. “Standard Page”).

3. Verify that the folder listed in the “Placement Folder” (the folder that the page will be created in) field is correct. If it needs to be changed, click in the field and select the correct folder.

4. **Optional:** Click the Metadata link in the Asset Action Toolbar and type in any information that you want. See Section 2.9 for more information on this section. When you are done, click the Content link in the Asset Action Toolbar.

5. College sites: Type in the desired values for the “Display Name” and “Title” for the page. The “Display Name” is the value that will be displayed in your site’s left navigation and breadcrumbs, and the “Title” is the value that will be displayed as the <title> tag.

   District and Intranet sites: Type in the desired value for the “Title” for the page. The “Title” is the value that will be displayed in your site’s left navigation, breadcrumbs, and the value that will be displayed as the <title> tag.

6. Insert your content into the editor by following the steps listed in Section 2.2 above.

7. Follow the instructions in Section 8.2 below to sort your new page in the navigation (if applicable)

8. **To Publish:** Publish the page you just created (Section 3.1), and publish any affected navigation by following the guidelines in Section 3.7 to publish any other assets affected by this action.
5. **SUBSECTIONS (colleges only)**

In addition to creating pages within a main Section (e.g. “About Us”), you may find it necessary to create a Subsection within that Section. This is useful for housing a related group of pages in one Section, making it easier for a site user to navigate your pages. The new Subsection link will display on the top and left navigation, and the left navigation will expand to show your Subsection’s pages.

![Image of Cascade Server user interface showing About Us section with Subsections]

### 5.1. Add a Subsection

Say you want to add a Subsection called “Our Commitment” to your main Section “About Us”. See the screenshot to the right for an example of how this navigation will look when we’re done. To do this:

1. Navigate to the folder that you wish to add the new Subsection to. In the Top Navigation Menu bar, click **+Add Content**, and then click **Subsection**.

2. Type in a “Display Name” and “Title” for your folder. The “Display Name” will be displayed as the section title, and the “Title” will be the value that will be displayed in the navigational structure. In this example, both should be set to “Our Commitment”.

3. Click **Submit** to save your new folder, then the **checkmark** button. This will create a new folder in the left asset tree.

4. In the left folder tree, inside the folder you just created, is a page named “default”. This is the subsection’s landing page. Edit this page, and fill in the desired contents. **⚠️ NOTE:** This page must be named “default” for your navigation to work properly. In our example, this will be the page that the user will land on when they click “Our Commitment” in the left or top navigation. The content or title of this page does not matter; it just needs to have a System Name of “default”.

5. In this new folder, follow the steps in Section 4 to create your new pages, and sort your pages as desired (see Section 8.2 below or sorting instructions).

6. Sort your new Subsection as desired (see Section 8.2 below for sorting instructions).
7. **To Publish:** Publish the folder you just created (Section 3.3), and publish any affected navigation by following the guidelines in Section 3.7 to publish any other assets affected by this action.

### 5.2. Edit a Subsection

If you need to change the Display Name and Title of a Subsection, or the folder’s System Name:

1. In the left folder tree, click on the folder that you want to edit, and then click the **Edit** tab.

2. Depending on what you change, different steps need to be followed:
   
   a) **“Display Name” and/or “Title”:**
   - Edit these values, and then click **Submit** to save your folder.
   - **To Publish:** Publish the folder you just edited, and then follow the guidelines in Section 3.7 to publish any other assets affected by this action.

   b) **Rename the Folder:** See Section 7.4.1.

### 6. Folders

The folder detail view can be seen by clicking on the desired folder in the left asset tree (click the corresponding arrow). The detail view shows all assets in that folder with details about each asset.

To sort by any column, click on the column’s title.

#### 6.1. Add a Folder

You can add a folder to any part of your Web site to organize files (images, PDF documents, etc.)

⚠️ **NOTE:** To add a folder for the purposes of adding a Subsection to your navigation, please see Section 5.1.

To add a folder:

1. Select the desired folder in the asset tree on the left that you want to add this new folder into, and then click **+Add Content**, and then click **Folder**.

2. Type in the desired folder name into the “System Name” field. You can ignore any Display Name or Title fields.

   ❗️ **NOTES:**
   - Do **not** put spaces in your file name. Instead of spaces, use hyphens.
   - **Make sure that your System Name does not have a space at the end of it.** This will cause Cascade Server publishing to fail.
   - Use all lowercase letters.

3. Click **Submit**. The folder will be created in the left folder tree, and you can begin adding assets to it.

4. **To Publish:** Publish the folder you just added. See Section 3.3.
6.2. Edit a Folder

For folders that are used to organize files (images, PDF documents, etc.), you can either move or rename a folder.

⚠️ **NOTE:** To edit a folder that contains pages, please see Section 5.2.

1. Depending on the needed edit, different instructions need to be followed:
   a. **Move:** See Section 7.4.1.
   b. **Rename:** See Section 7.5.

2. **To Publish:** Publish the folder you just edited, and then follow the guidelines in Section 3.7 to publish any other assets affected by this action.

7. Asset (File) Management

An asset in Cascade Server is any file within the system: a page, an image, a folder, etc. This Section covers the kinds of actions you can perform with these assets, including uploading files, modifying files, using the image editor, and copying, moving, renaming, and deleting assets.

See the Sections below for the two methods for upload files.

7.1. Uploading Files

In order to use any files in your content, you will first need to upload them into Cascade Server. You can upload any file type to Cascade Server. You can upload one file at a time, multiple files at once, or edit an existing file.

⚠️ **NOTE:** The maximum file size that can be uploaded into Cascade Server is **50 MB**.

7.1.1. Upload a Single File

1. In the left asset tree, click on the folder that you want to upload your file to.
2. In the top navigation bar, click **+Add Content**, and then click **File/File-Normal**.
3. If you want to keep the same name of the file that you are uploading, do not change the “System Name” field. The system will automatically use the name of the file being uploaded. Otherwise, you can change the name of the file in the “System Name” field.

⚠️ **NOTES:**
- While pages should not have an extension on its “System Name” value, files must keep their native file extension (e.g. “.pdf”). Do not remove these extensions.
- Asset names can only contain the following characters: upper- or lower-case letters, numbers, underscores, hyphens, and periods. All other characters will be rejected by Cascade Server.
- Make sure that your “System Name” field does not have a space at the end of it. This will cause Cascade Server publishing to fail.
4. Make sure the Placement folder is correct. If not, click in the field to select the correct folder.

5. You can upload a file using one of two ways:
   - From computer’s file browser, click and drag your file to the Cascade Server browser window, and release it in the “Drop file(s) here or choose some from your computer” area.
   - Or, click in the “Drop file(s) here or choose some from your computer” area. A popup window will be displayed, which shows the contents of your hard drive or network drive. Find the file that you want to upload and click on it. Then click the Open in the bottom right-hand corner of the window. The window will close.

6. If you are uploading an image, the image will be displayed inside of an image editor. To use the image editor, see Section 7.2. If you are uploading anything other than an image, you will not see a preview of the file.

7. Click the Save and Preview button at the top of the page, then click the Submit button. The page will reload with your uploaded file, placed into the folder you selected in Step 1. A preview of the file will be displayed on the right.

8. To Publish: Publish the file you just uploaded (Section 3.1).

9. Insert this file into your content.

7.1.2. Upload Multiple Files

If you have multiple files that you would like to upload, you can upload them all at once to save you time.

1. In the left asset tree, click on the folder that you want to upload your files to.

2. In the top navigation bar, click +Add Content, and then click File/File-Normal.

3. The system will automatically use the names of the files being uploaded.

⚠️ NOTES:
- While pages should not have an extension on its “System Name” value, files must keep their native file extension (e.g. “.pdf”). Do not remove these extensions.
- Asset names can only contain the following characters: upper- or lower-case letters, numbers, underscores, hyphens, and periods. All other characters will be rejected by Cascade Server.

4. Make sure the Placement folder is correct. If not, click in the field to select the correct folder.

5. You can upload the files using one of two ways:
   - From computer’s file browser, click and drag the files to the Cascade Server browser window, and release them in the “Drop file(s) here or choose some from your computer” area.
   - Or, click in the “Drop file(s) here or choose some from your computer” area. A popup window will be displayed, which shows the contents of your hard drive or network drive. Find the files that you want to upload and select them. Then click the Open in the bottom right-hand corner of the window. The window will close.
6. You will not see a preview of the files, just the filenames.

7. Click the Save and Preview button at the top of the page, then click the Submit button. The page will reload with your uploaded files, placed into the folder you selected in Step 1. A preview of the filenames will be displayed on the right.

8. To Publish: Publish the files you just uploaded (Section 3.1).

9. Insert the files into your content.

7.1.3. Update an Existing File

Updating a file that is already in the system requires uploading a new version of the file. To update a file that you have already uploaded, see the instructions below.

⚠️ NOTE: If you need to edit the properties of an image (size, orientation, etc.), see Section b).

1. In the left asset tree, select the file you wish to update, and then click Edit.

2. You can upload your file using one of two ways:

   a) From Windows Explorer or the Mac File Browser, click and drag your file to the Cascade Server browser window, and release it in the “Drop file here” area.

   b) Or, click the “Drop file here” area. A popup window will be displayed, which shows the contents of your hard drive or network drive. Find the file that you want to upload and click on it. Then click the Open in the bottom right-hand corner of the window. The window will close.

3. Click Submit. The file you selected in the system will be overwritten with the file selected. Then, publish your file (Section 3.1).

4. To Publish:
   a) Publish the file you just updated (Section 3.1).
   b) OPTIONAL: If you updated the file’s “System Name” value, you will need to publish all pages that call this file (Section 3.6).

7.2. Edit an Image

The image editor allows basic image manipulation operations without requiring any additional software. Once you have uploaded an image into Cascade Server, you can perform edits to that image. Specifics about the image editor are listed below:

<table>
<thead>
<tr>
<th>Available Actions</th>
<th>Applicable File Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Resize dimensions (maintaining aspect ratio or not)</td>
<td>• .gif, .jpg, jpeg, .png, .bmp</td>
</tr>
<tr>
<td>• Rotate clockwise/counterclockwise</td>
<td></td>
</tr>
<tr>
<td>• Flip horizontal/vertical</td>
<td></td>
</tr>
<tr>
<td>• Crop</td>
<td></td>
</tr>
<tr>
<td>• Undo/Redo</td>
<td></td>
</tr>
</tbody>
</table>
Below are instructions for using the image editor.

1. Begin editing the image by performing one of the following actions below:
   a) Upload a New Image and Edit
      If you want to edit an image when uploading it into Cascade Server for the first time, follow the instructions in Section 7.1.1, Steps 1-4 to upload your image. After performing these steps, the image editor will be displayed.
   b) Edit an Existing Image
      If you want to edit an image that already has been uploaded into Cascade Server, navigate to the image you want to edit, and click the Edit link.

2. In the image editor, perform the desired action. Each available editing action is listed in detail below:

   **Resize**
   a) Change the Width and the Height values to resize the image. When you change either of these values, the other value will change proportionally to keep the proper aspect ratio. To disable this feature in order to change each value independently, click the ‘lock’ icon in between these two ratios. **NOTE:** These values are in pixels.
   b) Press Enter to resize the image. To cancel your resize, click the **Undo** button or **Close** the window without saving.

   **Crop**
   a) Place your mouse cursor inside of the image, and click and drag to select the area of the image you want to keep. The selected area will be highlighted. To change the size of the selection, use the box “handles” to drag the selection. In addition, the selected width and height (in pixels) will be displayed just below your selection.
   b) Click the crop icon to crop the image. To cancel your crop, click the **Undo** button or **Close** the window without saving.

   **Rotate**
   Change the orientation of the image clockwise or counterclockwise.

   **Flip**
   Flip the image like a mirror, vertically or horizontally.

   **Undo/Redo**
   These actions work the same way as other programs. The “Undo” action is only available after performing one of the below actions, and the “Redo” action is only available after an “Undo” action is performed.

3. Click the **Save and Preview** button, then **Submit** to save your changes.

4. **To Publish:**
   - Publish the image you just updated (Section 3.1).
   - OPTIONAL: If you updated an image’s size, you will need to publish all pages that display this image (Section 3.6).
7.3. Copy Assets

To copy a page, file, or folder to another folder within Cascade Server:

7.3.1. Copy a Single Asset

1. While viewing the asset, click the ...More menu, then Copy.

2. OPTIONAL: Change the asset’s name in the “System Name” field.

**NOTES:**
- If you are renaming a page, do not add a file extension (e.g. “.aspx”). For example, if you are renaming the page to “default.aspx”, you will want to just type in “default”.
- While pages should not have an extension on its “System Name” value, files must keep their native file extension (e.g. “.pdf”). Do not remove these extensions.
- Asset names can only contain the following characters: upper- or lower-case letters, numbers, underscores, hyphens, and periods. All other characters will be rejected by Cascade Server.
- Make sure that your “System Name” field does not have a space at the end of it. This will cause Cascade Server publishing to fail.

3. Select the New Folder (destination folder) if necessary.

4. Click Copy. The file will be copied to the specified folder.

**NOTE:** Depending on the size of the file that you copied, it may be copied immediately, or you may get a message that the Copy task has been created and will be completed in the background. To check on the status of the copy, go to the Dashboard, and check on the Messages. When the copy is complete, a message will appear in this list, beginning with “Summary of copying...”. This means that the copy is complete.

5. To Publish:
   a) Publish the asset you just copied (Section 3.1).
   b) OPTIONAL: If you copied a page, publish any pages containing navigation affected by the change (Section 3.7).

7.3.2. Copy Multiple Assets

1. In the Asset Tree on the left, select the folder containing the assets you want to copy. A detailed list of those assets will be displayed.

2. Select the assets you want to copy by checking the boxes to the left of the desired assets’ names.

3. At the top of the folder list, select the Copy button.

4. Select the destination folder, and then click Copy, then Confirm Copy.

**NOTE:** Depending on the size of the file that you copied, it may be copied immediately, or you may get a message that the Copy task has been created and will be completed in the background. To check on the status of the copy, go to the Dashboard, and check on the Messages. When the copy is...
complete, a message will appear in this list, beginning with “Summary of copying...”. This means that the copy is complete.

5. **To Publish:**
   a) Publish the asset you just copied (Section 3.1).
   b) OPTIONAL: If you copied pages, publish any pages containing navigation affected by the change (Section 3.7).

7.4. **Move Assets**

To move a page, file, or folder to another folder within Cascade Server:

7.4.1. **Move a Single Asset**

1. You can move the asset by doing one of the following:

   1.1. **Drag and Drop:**
   - In the left folder tree, click and hold your left mouse button on the desired asset, and drag it to the desired folder. Let go of your left mouse button.
   - On the confirmation page, verify that the “New Folder” value is correct.
   - Proceed to Step #2.

   1.2. **More, Move link:**
   - In the left folder tree, single-click on the desired asset.
   - Click on **More link, Move**.
   - In the “New Folder” field, select the destination folder.
   - Proceed to Step #2.

2. By moving this asset, the asset will remain out on your website in its old location. This means that it can still show in search results. To prevent this, ensure that the “Unpublish Content” checkbox is checked. This will delete the old file from your website. Rarely, if you do not want to remove this asset from your live Web site, ensure that this checkbox is not checked.

3. Click the **Move button**. The asset will be moved to its new folder.

   **NOTE:** Depending on the size of the file that you moved, it may be moved immediately, or you may get a message that the Move task has been created and will be completed in the background. To check on the status of the move, go to the Dashboard, and check on the **Messages**. When the move is complete, a message will appear in this list, beginning with “Summary of...”. This means that the move is complete.

4. **To Publish:**
   a) Publish the asset you just moved (Section 3.1).
   b) OPTIONAL: If you moved pages, publish any pages containing navigation affected by the change (Section 3.7).
7.4.2. **Move Multiple Assets**

1. If you want to un-publish these assets from your live Web site before moving them (recommended), un-publish each asset by following the instructions in Section 3.5.

2. In the Asset Tree on the left, select the folder containing the assets you want to move. A detailed list of those assets will be displayed.

3. Select the assets you want to move by checking the boxes to the left of the desired assets’ names.

4. At the top of the folder list, select the **Move** button.

5. Select the destination folder, and then click **Move, Confirm Move**.

   **NOTE:** Depending on the size of the files that you moved, they may be moved immediately, or you may get a message that the Move task has been created and will be completed in the background. To check on the status of the move, go to the Dashboard, and check on the **Messages**. When the move is complete, a message will appear in this list, beginning with “Summary of ...”. This means that the move is complete.

6. **To Publish:**
   
   a) Publish the asset you just moved (Section 3.1).
   
   b) **OPTIONAL:** If you moved pages, publish any pages containing navigation affected by the change (Section 3.7).

7.5. **Delete Assets**

To delete a page, file, or folder to another folder within Cascade Server, follow the instructions below.

**NOTE:** To recover a deleted asset, see Section 10.1.

7.5.1. **Delete a Single Asset**

1. While viewing the asset, click the **More** tab, and then click **Delete**.

2. Ensure that the “**For publishable assets selected, unpublish from applicable destinations**” checkbox is checked if you want to remove the asset from your live Web site, as well as from Cascade Server. Rarely, if you do not want to remove this asset from your live Web site, ensure that this checkbox is **not** checked.

3. If other asset(s) are still using this asset, deleting it may cause broken links. You will get a message at the top of the page with a link to **More details**. Click on **More details** and take note of the pages in the “Relationships” list that have a page icon. You can ignore assets that do not have this icon.

4. Click the **Delete** button. The asset will be deleted from Cascade Server and from your Web site (depending on your setting from Step #2).

5. **To Publish:** If you deleted a page, publish any pages containing navigation affected by the change (Section 3.7). Otherwise, publishing is not necessary.
7.5.2. Delete Multiple Assets

⚠️ **NOTE:** When using this method, there is no way to determine which pages have links to these assets, and thus, will be affected by this delete action. If this is a concern, delete each asset one at a time per Section 7.5.1.

1. In the Asset Tree on the left, select the folder containing the assets you want to delete. A detailed list of those assets will be displayed in the right-hand window.

2. Select the assets you want to delete by checking the boxes to the left of the desired assets’ names. Then, at the top of the folder list, select the **Delete** button.

3. Ensure that the “**For publishable assets selected, unpublish from applicable destinations**” checkbox is checked if you want to remove these assets from your live Web site, as well as from Cascade Server. Rarely, if you do not want to remove these assets from your live Web site, ensure that this checkbox is **not** checked.

4. Click the **Confirm Delete** button. The assets will be deleted from Cascade Server and from your Web site (depending on your setting from Step #4).

5. **To Publish:** If you deleted pages, publish any pages containing navigation affected by the change (Section 3.7). Otherwise, publishing is not necessary.

7.6. Rename an Asset

1. While viewing the asset, click the **Move** menu, **Rename**.

2. Change the asset’s name in the “**New Page Name**” field.

⚠️ **NOTES:**

- If you are renaming a page, do not add a file extension (e.g., “.aspx”). For example, if you are renaming the page to “default.aspx”, you will want to just type in “default”.
- While pages should not have an extension on its “System Name” value, files **must** keep their native file extension (e.g., “.pdf”). **Do not remove these extensions.**
- Asset names can only contain the following characters: upper- or lower-case letters, numbers, underscores, hyphens, and periods. All other characters will be rejected by Cascade Server.
- Make sure that your “System Name” field does not have a space at the end of it. This will cause Cascade Server publishing to fail.

3. By renaming this asset, the previously-named asset will remain out on your website. This means that it can still show in search results. To prevent this, in the “Un-publish” Section, ensure that the “**Unpublish Content**” checkbox is checked. This will delete the old file from your website. Rarely, if you do not want to remove this asset from your live Web site, ensure that this checkbox is **not** checked.

4. Click **Rename**. The asset will be renamed.
5. **To Publish:**
   a) Publish the asset you just renamed (Section 3.1).
   b) OPTIONAL: If you renamed a page, publish any pages containing navigation affected by the change (Section 3.7).

### 7.7. Deactivate / Activate an Asset

You can temporarily remove a page from your site’s navigational structure, or deactivate a file. This will prevent the asset from being published, but will leave your asset in Cascade Server for later use.

#### 7.7.1. Deactivate an Asset

1. Follow the instructions in Section 3.5 to un-publish the asset.
2. Navigate to the asset that you wish to activate, and then click the **Edit** button, and then click on the **Configure** button at the top.
3. Uncheck the boxes for “Include when publishing” and “Include when indexing”.
4. Click the **Save and Preview** button, then the **Submit** button to save your asset.
5. **To Publish:** Publish any pages containing navigation affected by the change (Section 3.7).

#### 7.7.2. Activate an Asset

To activate an asset, follow the instructions in Section 7.7.1, Steps #2-5. In Step #3, check the boxes instead.

### 8. Manage Navigation Areas

The navigation areas of your Web site are automatically built by Cascade Server, but there are several actions you can take to manipulate these areas.

#### 8.1. Add an External Link

An “External Link” in Cascade Server is a way to add an item to your navigation that links the user to another Section in your current site, or to an external Web site. For example, say you wanted to link a user to the “Contact Us” Section from the “About Us” Section of your site.

To accomplish this, you would add a link called “Contact Us” into the “About Us” folder, which links to the “About Us” Section. This link would then be displayed in your navigation. When the user clicks on “Contact Us” in the left navigation of “About Us”, they will be taken out directly to the “About Us” Section. Likewise, you can add a link into your navigation that links to a file (PDF), or an external Web site.

To add a link to another asset within your site, or to add a link to an external Web site, follow the instructions below.

8.1.1. **Internal Reference link (District or Intranet website only)**

To add a link to another section within your site, first you will need to be able to view the asset in Cascade that you wish to link to. If you wish to link to another site, see Section 8.1.2.
1. Navigate to the asset that you want to link to.
   • **NOTE:** If your reference link is to a file, make sure the file has a title: click **Edit** and check to make sure the **Title** field has been filled in. This is the text that will show in the Navigation area. Click **Save & Preview**. You will see the title that has been entered and a reminder to click Submit to save changes. Click the **Submit** button, then **Submit** again.

2. With the file/page still selected, click the **More menu** from the upper right of the screen, and select **Reference**.

3. **Add ‘-link’** to the end of the **Reference Name**. This will help you remember what the link connects to. Note that this value is for internal purposes only and will never be seen by your Web site visitors.

4. Click on the **Placement Folder** and **browse to the folder where you want the link to be displayed**. Select the folder, click the **Choose** button, then the **Submit** button.

5. Your internal link will now be displayed in the **Left Navigation**
   - **NOTES:**
     - If the entry in the Left Navigation displays as `$SerializerTool.serialize($title, true)`, it means you did not fill in the **Title** field for the file or page you are linking to. Follow the instructions in step 1 to correct this.
     - Do not put an extension on the name (e.g. “.aspx”).

6. Follow the instructions in Section 8.2 to sort your new link in the navigation.

7. **To Publish:** Publish any pages containing navigation affected by the change (Section 3.7).

8.1.2. **External link (all sites)**

To add a link to another Web site, do the following:

1. Select the website folder where the link should be displayed. From the menu, select **+Add Content, For All Users, External Link**.

2. Add the **Link Name** (no spaces, special characters, or capital letters). Choose a different **Placement Folder** if necessary, **Title** (what text you want the link to display), and the **Link URL** including ‘http’ or ‘https’. Click the **Save & Preview** button. **NOTE:** Ensure that your link starts with **http://** or **https://**. Otherwise, the link will be broken.

3. You will see the draft of your link. Click **Submit** and **Submit** again.

4. Follow the instructions in Section 8.2 to sort your new link in the navigation.

5. **IMPORTANT:** Don’t forget to publish all pages containing navigation affected by the change!

8.2. **Sort Links**
The links in the navigation areas can be sorted easily. While looking at a folder’s detail view (Section 6), you can click on the “Order” column to display the sort order for that folder’s assets. To sort how your assets appear in your site’s navigation:

1. Click on the desired folder in the left asset tree containing the assets you want to sort. If your assets are not listed in ascending order in the “Order” column, click the “Order” column heading.

2. Place your mouse anywhere on the line of the asset you wish to move. Click and hold your left mouse button, and then drag the asset up and down to the desired position. Then, release your left mouse button. The sort order will change automatically. You can also select the asset you want to move and use the toolbar arrow buttons at the top to move the asset.

3. **To Publish:** Publish any pages containing navigation affected by the change (Section 3.7).

### 8.3. Remove a Link

It is possible to have a page on your site that is not listed in your navigational menus. This is useful if you have a page that you just want to link to, but don’t want listed in your navigation. To do this:

1. In the left folder tree, click on the asset that you want to remove from your navigation, and then click on the **Edit** tab.

2. Find the “Display in Left Navigation?” field, and select **No**.

3. Click **Save & Preview**, then **Submit** to save the page.

4. **To Publish:** Publish any pages containing navigation affected by the change (Section 3.7).

### 9. VERSIONS

Cascade Server keeps the last 20 versions of your assets, allowing you to restore a previous version of your page or file. This is especially useful if you make several modifications and need to back them out.

⚠️ **NOTE:** Only pages and files can be rolled back to a previous version.

#### 9.1. Restore a Previous Version

To preview and restore a previous version of an asset:

1. In the left folder tree, click on the asset that you want to change the version for.

2. In the Asset Action Toolbar, click the ...**More menu button**, and then click **Versions**. This will display a list of all available versions of your asset. The list will contain the path of the asset, the date of the version, who modified it, and any comments that the user entered.

3. Choose the asset version you wish to restore by clicking it, then click the **Restore this version** button. If you want to view the version, click on the name and Cascade Server will display the selected version.
4. While viewing a previous version, click again on the ...More menu button in the toolbar. You can perform the following actions with these options:

- **View newer**: Displays the next newer version of the selected asset.
- **View older**: Displays the next oldest version of the selected asset.
- **View current**: Displays the current version of the asset.
- **Restore**: Selecting this option will make the selected version the current version. By doing so, the previous current version will become the next-latest version.
- **Delete**: If you do not want to keep this previous version, you can select this option to remove it.
- **Compare with Current (pages only)**: Allows you to merge the current version and the selected version together, displaying what the differences are between the two versions.

5. While viewing the version you want to restore, click on ...More, Restore. The selected version will be implemented.

6. **To Publish**: Publish the page you just edited (Section 3.1).

9.2. **Delete Versions**

You have the ability to delete unwanted versions in order to keep the number of versions below 20. To do this:

1. Follow the instructions in Section 9.1, Steps #1-2.

2. In the list of versions, check the checkbox next to each version that you wish to delete.

3. Click the “Delete” button located under Past Versions.

4. On the confirmation popup, click the OK button. The selected versions will be deleted.

10. **MISCELLANEOUS FEATURES**

10.1. **Recycle Bin - Trash**

Cascade Server’s Trash Bin is a temporary holding area for deleted assets which helps prevent loss of content. Assets in the Trash Bin can be restored to their original location.

Assets that are deleted will remain in the Trash Bin for 30 days, and then be permanently deleted. To view and restore files in the Trash Bin:

1. Select the site to be restored. Click on the Trash icon in the upper left area of your screen.

2. You can restore one or multiple assets. Click the asset(s) you wish to restore using the checkboxes in the left column, then click the Restore button. It looks like a curved arrow.

3. The asset(s) will be restored to their original location.
10.2. Stale Content Reporting

Stale Content Reporting helps you to identify and manage site content that may need updating. The Stale Content dashboard includes a graphical summary of content needing review and a table view of each stale item. The “Stale Content” tab contains several actions to help manage stale content, including sending notifications to content owners and scheduling future review dates.

10.2.1. Summary Report

The Stale Content summary can be viewed within Cascade Server’s “Dashboard / Home Area” (Section 1.10). This gives you an overview of your site’s content freshness.

10.2.2. Detailed Report

To view detailed reports about your content, click on the general menu in the upper right corner of your screen (it looks like three horizontal lines). Click Reports. Once in the report view, you can select Stale Content or if you have entered review dates in any of your assets, you can select Content Up for Review.

1. Click on Filter Results if you wish to narrow your selections to a site, last updated range, Asset Type, and folder restrictions.

2. Click the report’s column headings to sort as desired.

3. You can take the following actions for a specific asset:
   a. To email someone about a specific asset, which will notify them that it needs to be updated, click the “Notify by Mail” button. A popup window will appear where you can enter their email address, username, or Cascade Group name. Then enter an optional message.
   b. To set a review date in the future, click the “Schedule Review” button. Select a date, and click Schedule Review.

   **NOTE:** To perform an action for more than one asset, check the boxes next to the desired assets.

4. To export a report to Microsoft Excel (CSV file), click the “Export CSV” link in the upper right-hand corner of the report.

11. Usability Guidelines

When editing your own content, maintaining a consistent look and feel across all pages is vital for your site’s visitors. Here are some guidelines for good usability practices.

- **Use consistent font types and colors.** If your site uses an Arial font, you should only use Arial in your content. Try to keep any colors consistent with your site’s color scheme.

- **Properly resize your images (Section 7.2).** Don’t put large images in your content. You will want to scale them down as to not overwhelm the user and push your text to the bottom of the page.

- **Don’t overuse bolding, italics, or capitalization.** These are all used for emphasizing a word or a sentence. Bolding or italicizing an entire paragraph or page, or capitalizing a headline or title, can detract from the look of your content and make it difficult to read.

- **Use consistent font sizes.** Try not to use very large font sizes. Use the same font size for a heading that
is used on another page in order to keep a consistent look.

- **Format bullets or numbered lists.** Always left-align bulleted or numbered lists. Centering these can confuse the user and make it hard for them to read down the list.
- **Always left-align paragraphs.** For a paragraph of text, you will always want to left-align the text. Centering or right-aligning will make the text more difficult to read.
- **Keep it professional.** Use the same standards that you would use when creating a document in a word processor.

### 12. COMMON PAGE FEATURES

Most pages throughout the site have some features that are the same. These features are described below.

⚠️ **NOTE:** Not all pages will have these features.

#### 12.1. Metadata

The “Inline Metadata” group can be found at the very top of the page after clicking the **Edit** tab, and contains:

- **Display Name:** The title that is displayed in the left navigation for this page.
- **Title:** The value that is displayed in the page’s `<title>` tag.
- **Main Title:** The title that is displayed above the content area.
- **Keywords:** Meta keywords
- **Description:** Meta description
- **Display in Left Navigation?** Determines whether this page will be displayed in the left navigation menu. When creating a page, this field is set to “Yes” by default.

#### 12.2. Asset Search

To conduct a basic search:

1. Click the **Search** bar in the upper-right-hand corner of the interface (it looks like a magnifying glass).
2. Enter your search word(s); the list of results will populate as terms are added.
   - Only those assets for which you have read or write access will be listed.
   - Assets in the current site will be listed first, with assets in other sites listed after.
3. Enter additional site, asset types and asset fields to narrow your search.

#### 12.3. Choose a File or Page

For File selection fields, select the file (image, PDF, etc.) you want to link to by doing the following:

1. Click the “Browse” link in the **Choose a file** window. You will see a list of folders and/or files.
   - Either type in the name of the folder or file in the **Search** field to search for it, or select a folder or file from the displayed history (if available). If you use this method, skip to Step 3.
2. Click on the appropriate folders until you find the folder which contains your file, and click on that file to select it. The path to the selected file will appear in the file details.
3. If the file you are choosing is an image, the image will be displayed.
4. Click **Choose**. The window will close, and the field will be populated in with the selected file’s path.

### 12.4. Links

To specify where something will link to when clicked, you will see a field named “Link: Choose File, Page, or Link” that will allow you specify what kind of link you want. You can create a link using one of three methods:

- Link to a page within Cascade Server by using the “Internal” Link Source selection, and then selecting the desired page (Section 12.3).
- Link to a file (PDF, etc.) within Cascade Server by using the “Internal” Link Source selection, and then selecting the desired file (Section 12.3).
- Link to an external Web site by using the “External” Link Source selection, and then typing in the full URL (i.e. http://www.beacontechnologies.com/) into the “URL” field. **NOTE:** You must enter the full URL, including the http:// or https:// value.

### 12.5. Date / Time

For any Date/Time field, in order to properly enter the date, click in the date field to select the desired date. **NOTE:** You must use the popup calendar field to enter the date, or use mm-dd-yyyy as the date format. After clicking in the date field, use the time icon to select the desired time (hour, minute, AM/PM).

### 12.6. Groups

#### 12.6.1. Expand / Collapse

To show the fields in a collapsed group, click on the item title to expand it. To collapse it, click on the title again.

#### 12.6.2. Add / Remove / Sort

Some groups and fields are set as “multiple”, which means you can add, sort, or remove that group or field. You can find these controls to the right of the item name.

- **Add:** Find the item that you want to add the new item AFTER, and then click the green + icon.
- **Remove:** Find the item that you want to remove, and then click the red X icon.
- **Sort:** Find the item that you want to move up or down in the list, and then click the up or down arrow.

### 13. STANDARD PAGE

A Standard Page is the most common type of page on your site. It allows you to have two columns (left navigation and content area), or 3 columns (left navigation, content area, and right column).

#### 13.1. Impact Image

The Impact Image contains a single large image that appears at the top of the page.

1. Click on the “Impact Image” group, and in the “Display?” field, select **Yes**.
2. Select your desired image in the “Image” field.

**NOTES:**
- The required image size is 1150 pixels wide by 205 pixels high.
- In order to have the correct design effect (shadow), you must use a Photoshop template when saving your image.

3. Enter the image’s alternate text (or ALT text) “Alt Text” field. **NOTE:** This value is required for Section508 compliance.

4. **To Publish:** Publish the current page (Section 3.1).

**13.2. Left Column**

The left column contains two optional regions that can be set on a page-by-page basis.

**13.2.1. Calls to Action**

This function gives you the option to add one or multiple “Calls to Action” to a page, which will appear below the left navigation. To insert a Call to Action:

1. Find the “Left Column” section, and click on the title to expand it. Within the “Left Column >> Calls to Action” section, choose either “Section Default” which will use the default information in that folder OR select “Content Below” if this page will have its own information.

2. Within the “Left Column >> Calls to Action >> Item” group, enter the text of the Call to Action.

3. Select the desired Link Type and Link for the Call to Action (Section 12.4).

4. Add, remove, or sort the Calls to Actions as desired (Section 12.6.2).

**13.2.2. Contact Information**

You can optionally add a block of contact information below the left navigation area. This block of content can be controlled by one of two methods:

- By default, all pages will display the contact information from the section’s homepage (e.g. “/about/default”).
- On each page, you can override the default settings and display different contact information.

**Section Default**

By default, all pages will display the contact information from the section’s homepage (e.g. “/about/default”). In other words, if you set the contact information on the section’s homepage, all of the pages in that section will display the same contact information. To set the contact information that will display on all pages throughout a section:

1. Navigate to the desired section’s “default” page (e.g. “/about/default”), and then click **Edit**. Then click on the “Left Column” title to expand it, and then click on “Contact Information”.

2. In the “Display on this Page Using” field, ensure that “Section Default” is selected.
3. Fill in the contact information.

4. Click **Save & Preview**, then **Submit** to save the page.

5. **To Publish:** Publish the folder containing the “default” page you just edited. See Section 3.3 above.

### Individual Pages

By default, all pages will display the contact information from the section’s homepage (e.g. “/about/default”) set above. However, you can also override this contact information on any page to give the page unique information. To override the default contact information on any page:

1. Navigate to the desired page, and then click **Edit**. Then click on the “Left Column” title to expand it, and then click on “Contact Information”.

2. In the “Display on this Page Using” field, select “Content Below”.

3. Fill in the contact information.

4. Click **Save & Preview**, then **Submit** to save the page.

5. **To Publish:** Publish the current page. See Section 3.1 above.

### 13.3. Content Area

The main, or middle column, of the page contains the main body of content, along with optional content widgets.

#### 13.3.1. Main Title

The Main Title field sets the title that appears above the content area.

#### 13.3.2. Main Content

This section contains the page’s main body of content.

#### 13.3.3. Content Area Widgets (colleges only)

This function gives you the option to add an Event widget to the bottom of the page’s main content. You will first need to create the widget) that will be called into this area (see Section 14). To insert a widget:

1. Ensure that the widget you want to use has already been created. To create, edit, or delete widgets, see Section 14.

2. Find the “Content Area Widgets” section, and click on the blue title to expand it. In the “Display?” field, select **Yes**.

3. In the “Select Widget” field, select the desired widget file from Step 1. The widgets are located in the following folder: `/widgets/events-widgets`.

4. Sort the widgets as desired (Section 12.6.2).
13.4. Google Map

Each Standard Page allows you to insert a Google Map with markers and information. You will need to know the longitude and latitude coordinates of the place you want to mark, and then enter that information into the page.

13.4.1. Find Location’s Longitude and Latitude Coordinates

First, you will need to find the longitude and latitude coordinates of the place you want to mark, and then enter that information into the page.

⚠️ NOTE: These instructions are for the “Classic” Google Maps, not the “New” Google Maps. You will know that you are in the correct mode if you have a large white left column next to the map when you visit Google Maps.

1. Go to the URL http://maps.google.com/. Enter the location’s address into the search bar, and click the Search icon.

2. Right-click on the red marker in the map. In the menu, select What’s here? A green arrow will appear, marking the exact location. ⚠️ NOTE: If the marker isn’t exactly where you want it to be, find the spot on the map you want to mark, and right-click there.

3. In the search bar at the top of the page, the latitude and longitude is displayed. Take note of these values. See the screenshot below. The green highlight is the latitude, and the yellow is the longitude.

⚠️ NOTE: Do not include the comma separating the two values.

![Google Map Screenshot](image)

13.4.2. Add / Edit a Location

To add a location to a Google Map page:

1. While editing the page, scroll down to the “Google Map” section. Then, click on the “Google Map >> Location” blue title to expand it.

2. In the “Display? Field, select Yes.
3. Enter the Latitude and Longitude for the location from Section 13.4.1 above.

4. Fill in the rest of the fields. These fields are for data that will appear in the information “bubble” when clicking on a marker.

5. Add, remove, or sort the locations as desired (Section 12.6.2). Note that sorting the locations does not change anything on the map.

13.5. Supplemental Content
The Supplemental Content region appears below the main body of content, and allows you to add an accordion section and/or content “buckets”. Each one is described below.

13.5.1. Buckets
A content bucket allows you to add a block of content below the main content area, which can contain a title, image, caption text, and optional link.

1. Find the “Supplemental Content” group, and then click on the “Buckets” group to expand it.

2. Ensure that “Yes” is selected in the “Display?” field, and then click on the “Supplemental Content >> Buckets >> Item” title to expand it.

3. Enter the title of the bucket into the “Title” field.

4. Enter your image into the “Image” field. **NOTE:** The required image size is 284 wide x 190 high.

5. Enter the content to appear below the image into the “Text” field.

6. Set the desired link (Section 12.4)

7. Add, remove, or sort buckets as desired (Section 12.6.2).

13.5.2. Accordion
The Accordion section allows you to add an unlimited number of links and associated content. When this area is generated, a user will be able to click on the link, and it will expand to show the associated content.

1. Find the “Supplemental Content” group, and then click on the “Accordion” group to expand it.
2. Ensure that “Yes” is selected in the “Display?” field.

3. Enter the title of the accordion area into the “Title” field.

4. Click on the “Supplemental Content >> Accordion >> Item” group that you want to edit.

5. Enter the desired link text into the “Title” field. This will be the text that the user will click on to expand the area.

6. Enter the desired content into the “Content” field.

7. Add, remove, or sort the accordion items as desired (Section 12.6.2).

13.6. Right Column

The Right Column area gives you the option to enter and display any free-form content (District and colleges), and/or add an unlimited number of widgets (colleges only), which will appear in the right column. Colleges will first need to create the widget(s) that will be called into this area (see Section 14). To display a widget:

1. Ensure that the widget you want to use has already been created. To create, edit, or delete widgets, see Section 14.

2. Find the “Right Column” section, and click on the blue title to expand it. Ensure that the “Display?” field is set to “Yes”.

3. Optionally, enter any free-form content into the “Sidebar Content” field.

4. In the “Select Widget” field, select the desired widget file from Step 1. The widgets are located in the following folder: /widgets/.

5. Add, remove, or sort the widgets as desired (Section 12.6.2).

13.7. Last Updated Date

If you want to display the page’s last updated date at the bottom of the page, in the “Last Updated Date” group, select Yes in the “Display?” field.

14. Widgets

A Widget is a block of content that, when created, can be inserted into pages that contain a right column. A single widget can be used in multiple places. When updated, the widget file will be published, and all pages calling that file will be automatically updated. The types of widgets that are available are:

- Content
- Events
- Faculty
- Image
- Links
- RSS
- Video
All widgets are located in the following folder: /widgets

Each widget is described in detail below. **NOTE:** This section deals with creating, editing, and deleting widgets. For instructions on how to insert an existing widget into a page’s left or right column, see Section 13.6.

### 14.1. Create a Widget (colleges only)

#### 14.1.1. Content

A Content widget provides you with a WYSIWYG editor, and allows you to create your own widget without any design restrictions.

1. In the Top Navigation bar, click **Add Content > Widgets > Content**.
2. In the “Page Name” field, replace the value with the desired file name of your new widget. Change the Placement Folder if necessary.
3. In the “Title” field, enter the desired title of this content block. In the “Text” WYSIWYG field, enter your desired content.
4. Click **Save & Preview**, then **Submit** to save the widget.
5. **To Publish:** Publish the widget file that you just created.
6. Insert your new widget into a page (see Section 13.6).

#### 14.1.2. Events

An Events widget and allows you to customize a category listing of upcoming events.

1. In the Top Navigation bar, click **Add Content > Widgets > Events**.
2. In the “Page Name” field, replace the value with the desired file name of your new widget. Change the Placement Folder if necessary.
3. Select the category of events that you want to display, the school and enter how many events you want displayed.
4. Click **Save & Preview**, then **Submit** to save the widget.
5. **To Publish:** Publish the widget file that you just created.
6. Insert your new widget into a page (see Section 13.6).

#### 14.1.3. Faculty

A Faculty widget and allows you to create a list of faculty from a specified department.
1. In the Top Navigation bar, click **Add Content > Widgets > Faculty**.

2. In the “Page Name” field, replace the value with the desired file name of your new widget. Change the Placement Folder if necessary.

3. In the “Department” field, select the desired department.

4. Click **Save & Preview**, then **Submit** to save the widget.

5. **To Publish:** Publish the widget file that you just created.

6. Insert your new widget into a page (see Section 13.6).

14.1.4. **Image**

An Image widget allows you to insert an image with an optional link.

1. In the Top Navigation bar, click **Add Content > Widgets > Image**.

2. In the “Page Name” field, replace the value with the desired file name of your new widget. Change the Placement Folder if necessary.

3. In the “Title” field, enter the title for this image. This will also be used for the image’s ALT text. In the “Image” field, select the image you wish to use.

4. Set the desired link (Section 12.4).

5. Click **Save & Preview**, then **Submit** to save the widget.

6. **To Publish:** Publish the widget file that you just created.

7. Insert your new widget into a page (see Section 13.6).

14.1.5. **Links**

A Links widget allows you to specify a title with a list of links underneath.

1. In the Top Navigation bar, click **Add Content > Widgets > Links**.

2. In the “Page Name” field, replace the value with the desired file name of your new widget. Change the Placement Folder if necessary.

3. In the “Main Title” field, enter the title for this image.

4. In the “Links >> Link” section, fill in the text of the link, and set the desired link (Section 12.4). Add, remove, or sort the links as desired (Section 12.6.2).

5. Click **Save & Preview**, then **Submit** to save the widget.
6. **To Publish:** Publish the widget file that you just created.

7. Insert your new widget into a page (see Section 13.6).

### 14.1.6 RSS

An RSS widget and allows you to display the contents of any RSS 2.0 feed.

1. In the Top Navigation bar, click **+Add Content > Widgets > RSS**.

2. In the “Page Name” field, replace the value with the desired file name of your new widget. Change the Placement Folder if necessary.

3. In the “RSS Full URL” field, enter the RSS feed’s full URL. **NOTE:** You must enter the full URL, including the http://.

4. Click Save & Preview, then Submit to save the widget.

5. **To Publish:** Publish the widget file that you just created.

6. Insert your new widget into a page (see Section 13.6).

### 14.1.7 Video

A Video widget allows you to display a YouTube video. You will need the 11-digit YouTube Video ID.

1. In the Top Navigation bar, click **+Add Content > Widgets > Video**.

2. In the “Page Name” field, replace the value with the desired file name of your new widget. Change the Placement Folder if necessary.

3. Fill in “Video Title” field with the video’s title.

4. Select the video’s thumbnail image in the “Video Thumbnail” field.

5. In the “YouTube ID” field, enter the 11-digit ID of the YouTube video you wish to display. Note that you do not need to enter the full YouTube URL, just the ID.

6. Click **Save & Preview**, then **Submit** to save the widget.

7. **To Publish:** Publish the widget file that you just created.

8. Insert your new widget into a page (see Section 13.6).
14.2. Edit a Widget
To edit an existing widget’s contents:

1. Make your desired changes to the widget, and click Save & Preview, then Submit to save it.
2. To Publish: Publish the widget file that you just edited. This will update the widget on all pages it’s called on.

14.3. Delete a Widget
When you delete a widget, you not only have to remove the widget file, but you must remove the widget from each page that calls the widget. It is critical that this be done in the proper order. To do this:

1. Edit the Web site page(s) that calls the widget you want to delete.
2. Find the “Select Widget” selection you want to remove, and click the red X icon. If there is only one selection, then click on the “Clear Selection” X icon.
3. Click Save & Preview, then Submit to save the page.
4. To Publish: Publish the page that you just edited.
5. Repeat Steps 1-4 for each page that calls the widget you want to delete.
6. Delete and un-publish the widget file you are removing. See Section 3.5 for un-publishing.

15. PHOTO GALLERY
A Photo Gallery page allows you to specify an unlimited number of images that will be displayed within a slideshow. You can also insert some introductory content above the slideshow (optional).

1. Ensure that all of your photos have been uploaded into Cascade Server.
2. In the left folder tree, select the folder you want to add the new page to, and then click +Add Content > Photo Gallery Page.
3. Enter your introductory content into the “Main Content” field (optional). This text will be displayed above the slideshow.
4. Find the “Photo Gallery >> Slide” group that you want to edit, and click on the blue title to expand it.
5. Select the image in the “Image” field. ▲ NOTE: The required image size is 680 pixels wide by 450 pixels high.
6. Enter the image’s title into the “Title” field. This value will also be used for the image’s ALT text.
7. Enter the image’s caption into the “Caption” field (optional).

8. Add, remove, or sort the slides as desired (Section 12.6.2).

9. Click **Save & Preview**, then **Submit** to save the page.

10. **To Publish:** Publish the page you just created. All slideshow images will be published automatically.

16. **DOCUMENT DIRECTORY (colleges only)**

The Document Directory page will automatically index all files within a specific folder, and display that file if it has a “Title” value entered. The directory will display the file’s Title, Date Added, File Size, and File Type. Below are instructions for creating a Document Directory page, as well as how to tag files to be included in the list.

16.1. **Tagging Files**

To tag files with the appropriate metadata, do the following either while uploading a file (Section 7.1.1), or while editing an existing file:

1. Enter the file’s title into the “Title” field.

2. By default, the file’s “Date Added” value in the listing page will be set to the date the file was uploaded into Cascade Server.
   - If you want to use the default value, then leave this field blank and skip to Step 3.
   - If you want to override this value and set your own, do so in the “Start Date” field (Section 12.5).

3. In the “Type” dropdown, select the type or types applicable to this file. You can select multiple types by holding the CTRL key while selecting.

4. Click **Save & Preview**, then **Submit** to save the file.

5. **To Publish:**
   a. Publish the file you just uploaded or edited.

16.2. **Add a Document Listing Page**

A Document Listing Page will automatically index all files within a folder, and display their properties in a list. To add a Document Directory page:

1. In the left folder tree, click on the folder that you want to add the new page to.

2. In the blue Top Navigation bar, click **Add Content > Document Directory Page**.

3. Click **Save & Preview**, then **Submit** to save the page.

4. **To Publish:**
   a. Publish the page you just created.
   b. You must also publish all pages that contain this new page’s link in the left navigation.
17. **Homepage (Administrators Only)**

17.1. **Media (Slideshow)**

To edit the large slideshow, or media area:

17.1.1. **Button**

This section will set the value for the Call to Action button in the lower right-hand side of the slideshow.

1. Find the “Media” section, and then the “Button” section.

2. Set the desired image. **NOTE:** The required image size is 142 pixels wide by 27 pixels high.

3. Set the desired link (Section 12.4).

17.1.2. **Slideshow**

To set the slides:

1. Find the “Media” section, and then the “Item” section.

2. To set the larger orange text, fill in the “Tagline – Left Text” field. To set the white text that appears to the right of the orange text, fill in the “Tagline – Right Text” field.

3. Select your desired image in the “Image” field.

**NOTE:**
- The required image size is 1158 pixels wide by 563 pixels high.
- In order to have the correct design effect (shadow), you must use a Photoshop template when saving your image.

4. Set the desired link (Section 12.4).

5. Add, remove, or sort the slides as desired (Section 12.6.2).

17.2. **News**

Cascade Server will automatically feed five News postings to the homepage. To override the first posting with one that you manually specify:

1. Find the “News” or “Events” section, and click on the page to edit it.

2. Select “Yes” for the “Show on home page” field and Check “Yes” for the News article “Spotlight Article?” checkbox.

3. Using the “Start Date” and “End Promotion Date” fields, specify how long you want this story to remain spotlighted.
17.3. Callouts

The homepage callouts appear in a rotating banner in the lower left-hand corner of the homepage. To maintain this area:

1. Find the “Callout” group, and click on the blue title to expand it.

2. Enter your image into the “Image” field. **NOTE:** The required image size is 293 pixels wide by 215 pixels high.

3. Specify how long this callout will be displayed by utilizing the “Start/Stop Promotion Date” fields.

4. Set the desired link (Section 12.4)

5. Add, remove, or sort callouts as desired (Section 12.6.2).

18. PEOPLE SITES (ADMINISTRATORS for Colleges ONLY)

The Faculty/Staff sites locations are:

- All Sites: /people/
- Listing Page: /people/default

18.1. Add a People Site

1. In the top navigation bar, click +Add Content > Faculty-Staff Member.

2. Enter the faculty/staff member’s name and any other desired information into the “Display Name” and “Title” fields.

3. Click Save & Preview, then Submit. The faculty/staff member’s site folder will be created in the left folder tree.

4. In the left folder tree, edit the “default” page.

5. Enter the faculty/staff member’s name and any other desired information into the “Display Name” and “Title” fields.

6. Fill in the requested information within the edit screen.

7. In the “Photo” field, select the desired faculty/staff member’s photo (optional). **NOTE:** The required image size is 120 pixels wide by 154 pixels high.

8. In the “Courses” group, add this faculty/staff member’s course information. Add, remove, or sort the courses as desired (Section 12.6.2).

9. Click on the “Instructor Content” group, and fill in the requested information.
10. Click **Save & Preview**, then **Submit** to save the page.

11. Add additional pages to this folder (Section 4).

12. **To Publish**:  
   - Publish the folder that you created in Step #3.  
   - Publish the following page: `/people/default`.

### 18.2. Edit a People Site

If you need to make changes to an existing profile:

1. Edit the profile folder or page, or any page within that folder, then save and submit it.

2. **To Publish**:  
   - Publish the folder that you created in Step #3.  
   - Publish the following page: `/people/default`.

### 18.3. Delete a People Site

If you need to delete a faculty/staff site, follow the instructions below.

1. Delete and un-publish the profile folder per Section 7.5.1.

2. **To Publish**: Publish the following page: `/people/default`.

### 19. DEPARTMENT PAGES (colleges only)

#### 19.1. Department Landing page

The purpose of the Department Landing page is to provide a page that is linked to from the faculty/staff profile pages for each department. The department landing page does not need to be named “default” and it does not need to be saved in the academics/programs-departments folder. The faculty listing table is optional on this page (to create a page that shows a faculty listing table but is not linked from the faculty profile pages, create a “Department Listing Page”. **There should be exactly one department landing page per department.**

1. Select the folder to which the Department Landing page should be added
2. Go to **+Add Content > Department Landing page**
3. Select the Department(s) that should appear on this page. You may select multiple departments which will cause this page to be the page that is linked to from the faculty/staff profiles of each selected department.
4. To display a “Faculty Listing” table, select the “yes” radio button for “Display Faculty Listing”. All faculty members that have selected that department in their faculty profile page will then be displayed in the table on this page. The department name that displays in the department column in the faculty listing table is the value selected in the department field on that faculty member’s profile page.
5. **There should be only one Department Landing page per department.**
19.2. **Department Listing page**

The purpose of the Department Listing page is to provide a way to display the “faculty listing” table on a page without having it be the page that is linked to from the faculty/staff profile pages for each department.

1. Select the folder to which the Department Listing page should be added
2. Go to +Add Content > Department Listing page
3. Select the Department(s) that should appear on this page. You may select multiple departments, all of which will be represented in the faculty listing table, if selected.
4. To display a “Faculty Listing” table, select the “yes” radio button for “Display Faculty Listing”. All faculty/staff members that have selected that department in their faculty/staff profile page will then be displayed in the table on this page. The department name that displays in the department column in the faculty listing table is the value selected in the department field on that faculty/staff member’s profile page.
5. You can add more than one Department Listing Page to a folder.

19.3. **Dropdown Menus**

To maintain the “Departments” dropdown menu that appears on all pages:

**19.3.1. Add an Item**

1. Click on the menu in the top right of the screen (three horizontal bars), navigate to Manage Site > Metadata Sets, and then click on Department Listing (Cuyamaca)/Department Page (Grossmont).

2. Click the Edit link at the top, then click Custom Fields.

3. Find the “Department” field. At the bottom of the list, click the Add Value button. A new field will appear. Enter the department’s name into the blank field.

4. To Sort: Hover your mouse over the icon just to the left of the field, and then drag and drop the field in the list to keep the list in alphabetical order.

5. Click Submit to save the Metadata Set.

6. Repeat Steps 1-5 for the following Metadata Sets:
   a. Faculty Page
   b. Widget Faculty

**19.3.2. Edit / Delete an Item**

Editing or deleting a dropdown menu item is not recommended. If you change a dropdown menu item’s name, any page with that item selected will lose that selection. Thus, you will need to edit each page and re-select a new item. However, if it is necessary to rename or delete a dropdown menu item, do the following:
1. Follow the instructions in Section 18.4.1, Steps 1-2.
   - If Renaming: In Step 3, simply change the desired value.
   - If Deleting: In Step 3, delete that line by clicking the corresponding red X.

2. Click Submit to save the Metadata Set.
3. Edit each page that had the item selected, and select a new item.
4. When you are done, scroll to the bottom and click the Submit button.
5. To Publish: Publish all pages that you edited in Step 3.

20. **CALENDAR (ADMINISTRATORS ONLY)**

20.1. Definitions

- Event—Individual page in Cascade created by either a Cascade content editor going to District site > +Add Content > Calendar > Event OR an outside contributor submitting the public form and a page being created automatically.
- Calendar Grid—Listing page of all events in one month shown in “calendar” format.
  - District/calendar/default
  - Grossmont/campus-life/calendar
  - Cuyamaca/campus-life/calendar
- Workflow—Process used to review, edit, approve and publish an event submitted by the public via the “Submit Event” form
- Event Widget—Page that can be created to display events in a bulleted list for any category or categories on any standard page on the site.

20.2. Add an Event in Cascade

This function is only in the “District” site. **All Calendar listings are published nightly.**

1. Select the appropriate year and month folder for the event (i.e. /calendar/2015/01).
   - **NOTE:** All event postings must be saved into a “year/month” folder (e.g. “2014 > 08) in order to be displayed properly on listing pages.

2. Click +Add Content > Calendar > Event

3. Enter the event’s name into the “Title” field (required), and summary text into the “Summary” field (optional).

4. The “Start Date” and “End Date” fields allow you to determine when this event should be posted, and when it should be removed.
   - **NOTE:** The “Start Date” value determines when this event will be available to be viewed and published.
   - Thus, this event will not be displayed on any listing pages, or be able to be published, until this date has been reached.

5. In the “School” dropdown, select the grid and home pages that this event should be displayed upon (Cuyamaca, Grossmont, District). You can select multiple by holding the CTRL key while selecting.

6. In the “Category” dropdown, select the category or categories applicable to this event. You can select multiple categories by holding the CTRL key while selecting. This selection will determine how this event
is filtered on the grid pages, which printable calendars it appears upon and which event widgets it appears upon.

7. Check or uncheck the “Exclude From Main Calendar?” check box to determine if this event should show on the grid pages. Checking this box removes it from any default grid calendar (like http://www.grossmont.edu/campus-life/calendar.aspx), but it does not remove it from any printable calendars or department calendars.

8. Enter the event’s dates and times into the “Event Starts” and “Event Ends” fields. If this is an all-day event, you will need to check the “All Day?” checkbox.

9. Within the “Repeat” group, set the appropriate values for this event. If this is a single occurrence of the event, then you do not need to modify anything in this group. These properties work like Microsoft Outlook.

10. Enter the event content into the “Details” field.

11. Enter the location details into the “Location” field.

12. If you would like to add images to this event, find the “Image” group.
   a. Select the desired image(s) in the “Image” field.
   b. Enter the image’s alternate text (or ALT text) “ALT Text” field. ▶ NOTE: This value is required for Section 508 accessibility compliance.

13. To add contact information for this event, enter this information into the “Contact” group (optional). This is displayed on the event detail pages.

14. If you would like to add a related link to the event, find the “Related Link” group:
   a. Enter the text of the link into the Related Link “Title” field.
   b. Set the desired link.

15. To add author information for this event, enter this information into the “Author” group (optional). This is not displayed on the event detail pages.

16. Click Save & Preview, then Submit to save the page.

20.2.1. Publishing New Events

All new events will be automatically published each night along with all Calendar grid pages. If you need to publish an event immediately:

1. Ensure that the event’s Start Date value is set in the past.

2. Publish the event page you just created.

3. Publish the grid pages within the applicable site(s). Depending on which of the three sites (District, Cuyamaca, or Grossmont) your event should be displayed on, you may need to perform these steps on one or multiple sites:
   a. Click on the following file in each of the sites you want to update: /_admin/Publish Calendar Listings
      - Production

      Click on the External link that appears in the screen. This will bring up a Publish Set. Click on the Publish link, then the Publish button. The listing pages containing your new event will be
20.2.2. Edit an Event

If you need to make changes to an existing event:

1. Locate the event in its District site calendar month and year subfolder. Edit the event page, click **Save & Preview**, then **Submit** to save the page.

2. **To Publish:**
   a. Publish the page that you just edited.
   b. Publish the listing pages within the applicable site(s). Depending on which of the three sites (District, Cuyamaca, or Grossmont) your event should be displayed on, you may need to perform these steps on one or multiple sites:
      i. Click on the following file in each of the sites you want to update: */_admin/Publish Calendar Listings*
      ii. Click on the External link that appears in the screen. This will bring up a Publish Set. Click on the Publish link, then the Publish button. The listing pages containing your new event will be published.

20.2.3. Delete an Event

If you need to delete an existing event:

1. Delete the event page. Be sure to un-publish the asset as well when deleting.

2. **To Publish:** Publish the listing pages within the applicable site(s). Depending on which of the three sites (District, Cuyamaca, or Grossmont) your event should be displayed on, you may need to perform these steps on one or multiple sites:
   a. Click on the following file in each of the sites you want to update: */_admin/Publish Calendar Listings*
   b. Click on the External link that appears in the screen. This will bring up a Publish Set. Click on the Publish link, then the Publish button. The listing pages containing your new event will be published.

20.3. Add a Year Folder

Each year has its own folder that articles are kept in for organizational purposes. To add a year folder:

1. In the top navigation bar, click **Add Content > Calendar > Yearly Events Folder**.

2. Enter the year into the “Title” field, and then click **Submit** to save the folder.

3. Within the new year folder, click on the “default” page, and then click the **Edit** link.

4. Enter the year into the “Title” field, then click **Save & Preview**, then **Submit** to save the page.

5. **To Publish:** Publish the folder you just created.
20.4. Public Event Submission

When a public Web site visitor submits an event, the following steps will occur:

- An event page will be created automatically within Cascade Server, which will contain all of the information that the public user entered. The event will not be visible on the Web site yet, nor will it be eligible to be published from Cascade Server.

- A workflow will be started, and all users within the “D-Calendar Admin” group will be notified via Cascade system email that an event has been submitted.

- A user from the “D-Calendar Admin” group will need to take ownership of the workflow. That user can edit the event in Cascade, approve it to be published to the live site, or delete the event.

To edit, approve, or delete an event after receiving the notification email:

1. To access the page in the workflow, you can either click View the workflow screen in the email (you may need to log in), or click Workflows on the Cascade Server dashboard My Content screen, and then clicking the workflow name. Note: If My Content does not show, click +Add Widget, My Content.

2. From the Workflow screen, click [Assign this step to Me] in the workflow screen.

3. To review the contents of the event, click the Back to Page link. The page will be displayed. When you are done reviewing the content, click the Calendar Event Submission link to return to the workflow screen.

   **NOTE:** Do not attempt to edit the page’s content by clicking on the Edit tab in the Asset Action Toolbar.

   The page is not editable at this point.

4. Choose one of the following actions below:
   - Edit Event Posting
   - Publish Event Posting
   - Delete Event Posting

20.4.1. Edit Event Posting via Workflow

The approver can edit the contents of an event posting before approving and publishing it. To do this, from the workflow screen, do the following:

1. On the workflow screen, in the “Ordered Step Name” section, under “Actions”, click Edit Event Posting.

2. Enter any desired comments for what you are editing. These comments will be displayed in the workflow history listing. When you are done, click the Submit button.

3. Make the necessary edits to the page.
   - **To View the Page:** Click the View link in the Asset Action Toolbar. This will allow you to see the page with your edits as it will look once it’s live.
   - **To Rename the Page:** In the toolbar area at the top, click the ...More/Rename link. Change the name in the “New Page Name” field, and then click the Rename button. Then, click the Edit tab again.
   - **To return to the “Edit” screen:** Click the browser’s “Back” button.

4. When you are done with your edits, click Submit.
5. Enter any desired comments for what you are editing. These comments will be displayed in the workflow history listing. When you are done, click the Submit button. You will then be returned to the workflow screen.

6. If you need to make additional edits, in the “Ordered Step Name” section, under “Actions”, repeat Steps 1-5. Otherwise, proceed to next section.

**20.4.2. Publish Event Posting via Workflow**

If you are done with edits to the page, you can now approve the event, which will also publish it to the live Web site. To do this:

1. On the workflow screen, in the “Ordered Step Name” section, under “Actions”, click Approve and Publish.

2. Enter any desired comments for what you are editing. These comments will be displayed in the workflow history listing. When you are done, click the Submit button.

3. You will be returned to the workflow screen. At this point, the event page has been sent into the publishing queue, and will be published to the live site. The workflow is now complete.

4. The event will be displayed on applicable listing pages after the nightly publish job is complete. If you want to make this event available immediately on the applicable listing pages, publish the listing pages within the applicable site(s). Depending on which of the three sites (District, Cuyamaca, or Grossmont) your event should be displayed on, you may need to perform these steps on one or multiple sites:
   a. Click on the following file in each of the sites you want to update: /_admin/Publish Calendar Listings
   b. On the right-hand side of the screen, click the Submit button. The listing pages containing your new event will be published.

**20.4.3. Delete Event Posting via Workflow**

If you need to delete a submitted event, do the following:

1. On the workflow screen, click the Delete Workflow link in the top right corner.

2. Click the OK button to confirm the delete. The workflow and event submission will be deleted.
20.5. Calendar Grid Pages

Calendar grid pages are the listing pages that display calendar events in grid format.

- The District Calendar grid page is located here: District/calendar/default
- School Calendar grid pages:
  - Grossmont – Main Site/campus-life/calendar
  - Cuyamaca – Main Site/campus-life/calendar

The following items can be safely edited on these pages:

- Title—Used in browser tab
- School—determines which School’s events are displayed on this page
- Category—determines which event categories are displayed on this page
- Include in left navigation—Determines if this page is displayed in the left navigation of other pages in the section
- Enable Popovers-- controls whether clicking an event on the grid pages triggers a message box with additional details of the event over the calendar, or immediately jumps to the detail page for that event.

Please consult Beacon Technologies before editing other elements of this page.

20.6. Filters on Grid Pages

The “Events for” filters are the selected categories for each grid page. If only two categories are selected on that page, then there will only be two filters next to the grid. The sort order and color display is controlled by the “/calendar/calendar-library/category-colors/category color mapping” page.

20.6.1. Update the Color Mapping for Grid Page

To update the color mapping for the grid page category filters:

1. Go to District site/calendar/calendar-library/category-colors/category color mapping
   (https://cms.gcccd.edu:8443/entity/open.act?id=6ab9bf0c0a01026501800808be1b1f35&
   type=block&)
2. Enter the hex code for the colors you want to be matched to each category.
3. The “Text Color” is the color that will display for that category’s color on the grid. Don’t make the text color white if the category color is yellow as this will make the words difficult to read.

20.7. Printable Calendars

The links under “Categories” on the grid page correspond to the Printable Calendars that have been created for this school. To create a new printable calendar for display in the right column of the grid page:

- Go to the District site/calendar/printable-calendar-listings folder
- Select +Add Content > Calendar > Category Listing
- Select the school grid pages that this page should appear upon
- Select the categories of event pages that should appear on this page

Adding or removing printable calendars will determine which listings are displayed in the right nav of the calendar grid pages.

20.8. Event Widgets (colleges only)

An Events widget and allows you to customize a category listing of upcoming events.

1. In the Top Navigation Menu bar, click +Add Content > Widgets > Events.
2. In the “Page Name” field, replace the value with the desired file name of your new widget.
3. Select the category of events that you want to display, the school and enter how many events you want displayed.

4. Click Save & Preview, then Submit to save the widget.

5. To Publish: Publish the widget file that you just created (very important, as the page that the widget is added to will break if not published).

6. Insert your new widget into a page.

20.9. Home Page Calendar Events

Cascade Server will automatically feed Calendar Events postings to the homepage. To control posting on the home page:

1. Find the Calendar event page, and click on the page to edit it.
2. Select “Yes” or “No” for the “Show on home page” field.
3. Using the “Start Date” and “End Date” fields, specify how long you want this event to remain on the homepage.

20.10. Updating Category List

To update the list of categories that appear on the event detail data definition and control which events are displayed on all calendar listing pages and the home pages, the following pages must all be edited and synchronized:

- District: Manage Site > Metadata Sets/calendar/Category Listing
  (https://cms.gcccd.edu:8443/entity/open.act?id=6abd4f220a010265018008081dfdbfa8&type=metadata set) -> Dynamic Fields -> categories

- District: Manage Site > Metadata Sets/calendar/Event
  (https://cms.gcccd.edu:8443/entity/open.act?id=6abfb1ff0a0102650180080819f752ec&type=metadata set) -> Dynamic Fields -> categories

- District: Manage Site > Data Definitions/calendar/Color Mapping
  (https://cms.gcccd.edu:8443/entity/open.act?id=6ac111e00a010265018008086cb012cd&type=structure ddata_tadefinition& ) -> system-data-structure - > Category - > Category

- District:/calendar/calendar-library/category-colors/category color mapping
  (https://cms.gcccd.edu:8443/entity/open.act?id=6ab9bf0c0a01026501800808be1b1f35&type=block& )Edit and make sure there is one and only one record for each category and that all class names are unique.

- Cuyamaca – Main Site: Manage Site > Data Definitions/Widgets/Events Widget
  (https://cms.gcccd.edu:8443/entity/open.act?id=d737d35b0a01026501800808f63b2595&type=structur edda_tadefinition& ) -> system-data-structure - > Content - > Events - > Event Category

- Grossmont – Main Site: Manage Site > Data Definitions/Widgets/Events Widget
  (https://cms.gcccd.edu:8443/entity/open.act?id=d737d35b0a01026501800808f63b2595&type=structur edda_tadefinition& ) -> system-data-structure - > Content - > Events - > Event Category
20.11. Unused Base Features

The following items are part of the “base” Hannon Hill calendar setup and are not currently in use. Beacon can hide these items if desired:

- +Add Content > Calendar/Term Listing—Another one of the base calendar page types. GCCCD doesn’t use this page type at this time. This content type is similar to the Category Listing except that start and end dates are chosen and it only displays events in that “term”. If not needed, we can disable the asset factory so it is not seen in the +Add Content drop down.
- “Sidebar” section on several pages - This is a default sidebar region that appears to the right of the calendar grid but is not currently used on GCCCD pages. These fields can be removed from the data definition so they won’t be seen while editing the grid pages.

20.12. Additional Calendar Information

1. Does selecting Categories on the default page only affect the District calendar page? For example, if we removed CC Athletics Calendar, this would not affect it showing on the Cuyamaca calendar page, correct? Correct, it only affects the display of these categories on the default page being edited.

2. What does selecting the school on the District calendar default page do? How does it affect what displays on the District, Cuyamaca, and Grossmont calendar pages? Changing the “School” selected on this page affects only the display of this default page and not the Cuyamaca and Grossmont pages. This field tells the page what matching events to show, by first selecting all the events that match the selected “School(s)” and then match the selected categories on this page.

3. How is a sub-calendar (under District > calendar/department-calendars folder) designated to show on the right column of a particular school or District calendar? (the Cuyamaca Academic Calendar shows on just the District and Cuyamaca currently, even though Grossmont is also selected) On department calendars, the school field is ignored and it displays all events that match the selected categories.
21. **NEWSLETTER ARCHIVE (ADMINISTRATORS ONLY)**

The Newsletter Archive template allows you to list past issues of a newsletter.

1. Create an archive page by clicking **+Add Content > Newsletter Archive Page**.
2. Scroll down to the “Newsletter Archive” section.
3. Enter the archive’s name, set an image/logo (optional), and the image’s ALT text.
4. Click on the “Issues” group to expand it.
5. Fill in the required information for that specific issue.
6. Set the desired link (Section 12.4)
7. Add, remove, or sort issues as desired (Section 12.6.2).
8. Click **Save & Preview**, then **Submit** to save the page.

22. **EMERGENCY MESSAGE (ADMINISTRATORS – Colleges ONLY)**

The Emergency Message will be displayed on all pages when active. You will need to activate it, edit the content, and publish the file.

1. Edit the following file:  `/includes-cms/emergency`.
2. In the “Display Emergency Text?” field, select “Yes”.
3. In the “Banner placement?” field, determine where you want the message to appear.
4. In the “Emergency Text” field, enter the emergency message’s content.
5. Click **Save & Preview**, then **Submit** to save the page.
6. To Publish: Publish the current page.
7. To turn off the message, select “No” in the “Display Emergency Text?” field, and then publish the file again.

23. **EMERGENCY MESSAGE (ADMINISTRATORS – District ONLY)**

The Emergency Message will be displayed on all pages when active. You will need to activate it, edit the content, and publish the file.

1. Edit the following District page:  `/default`.
2. If you have permissions, the Emergency Banner section will show. In the “Display Emergency Text” field, click the check box for “Yes”.
3. Select a banner color (recommendation is Blue for important notices and Red for crises)
4. In the “Emergency Text” field, enter the emergency message’s content. You can use Heading and text styles to emphasize text where needed.
5. Click **Save & Preview**, then **Submit** to save the page.

6. **To Publish**: Publish the default page.

To turn off the message, edit the page, unchecking the “Display Emergency Text” field, click Save & Preview, then Submit and publish the page again.

### 24. SITE MAP (ADMINISTRATORS ONLY)

The Site Map is automatically published each night. To manually publish it, publish the following file:

/site-map/default.

### 25. TOP NAVIGATION AND FOOTER (ADMINISTRATORS – colleges ONLY)

#### 25.1. Top Navigation (Mega Menu)

- **NOTE**: Utility Bar can be altered in _internal > formats > search-dropdown file; then publish the includes-cms > header > utility > utility page
- **NOTE**: Top Tabs can be altered in _internal > blocks > static > tabs; then publish the includes-cms > header > utility > top-tabs page

The Mega Menu’s links and callouts can be manually set by the Webmaster. It is split into an include per link (Enrollment, Academics, etc.). Each of these include files are located in the following folder:

/includes-cms/header/topnav

To edit a Mega Menu:

1. Click the **Edit** link.

2. Change the main link’s text in the “Main Link Text” field. Then, link to this section’s “default” page (e.g. /campus-life/default). This will be the page a visitor lands on if they don’t have JavaScript enabled, and they click on the main link.

3. Find the “Column” group that you want to edit. You can add, remove, or sort the columns (Section 12.6.2).

4. Each bolded link in the Mega Menu is contained within the “Column >> Link Group” group
   a. Select the desired group, and enter the link’s text into the “Text” field.
   b. Set the link for this bolded link in the “Column >> Link Group >> Main Link >> Link…” fields. You can add, remove, or sort the bolded links as well (Section 12.6.2).

5. Links that show beneath this bolded link are set in the “Column >> Link Group >> Sub Link” group.
   a. Select the desired group, and enter the link’s text into the “Text” field.
   b. Set the link for this bolded link in the “Column >> Link Group >> Sub Link >> Link…” fields. You can add, remove, or sort the bolded links as well (Section 12.6.2).
6. You can optionally add Calls to Action to each Mega Menu section, which allows you to specify an image, and link it.
   a. Find the “Column >> Calls to Action”, and select the “Item” group that you want to edit.
   b. Select the desired image in the “Image” field.
   c. Enter the image’s ALT text, a description of the image.
   d. Link the image (Section 12.4).
   e. You can also add, remove, or sort items as well.

7. You can optionally add Callouts to each Mega Menu section, which allows you to specify text, and link it.
   a. Find the “Column >> Callouts”, and select the “Item” group that you want to edit.
   b. Enter desired text for the callout into the “Text” field.
   c. Enter the image’s ALT text, a description of the image.
   d. Link the image (Section 12.4).
   e. You can also add, remove, or sort items as well.

8. Click Save & Preview, then Submit to save the file.


25.2. Footer
The footer is held in an include file so that it can be updated without having to publish the entire site.

- HTML location: /_internal/blocks/static/footer
- File to Publish: /includes-cms/footer

26 REDIRECTS AND VANITY URLs (colleges only)
You have the ability to create a redirect page or a “Vanity URL”, which is a shortened URL that you can use in your marketing materials. This URL will forward to the page of your choice within your Web site. Each option is described in detail below.

26.1. Redirects
A Redirect is a page that you can place anywhere within the site, and have that URL redirect to any other page within your website that you want. This is typically used when you move or rename a page.

26.1.1. Add a Redirect
   1. In the left folder tree, navigate to the folder you want to add the redirect to.
   2. In the top navigation bar, click +Add Content, then Redirect, and then click Page.
   3. In the “Page Name” field, replace the value of “default” with the desired value. This value will be what shows just after your Web site domain name, as ‘financial-aid’ is displayed in the below example: http://www.mycollege.edu/admissions/financial-aid.aspx
   4. In the “Redirect to Page” field, select the page within your website that you want the user taken to.
5. Click **Save & Preview**, then **Submit** to save the page.

6. **To Publish:** Publish the current file.

7. **Test** your new redirect URL by entering into your browser:
   
   http://www.mycollege.edu/admissions/financial-aid.aspx, where ‘financial-aid’ would be replaced by the value you entered in Step 3 above. You should be forwarded to the page or file you selected in Step 4 above.

### 26.1.2. Remove a Redirect

To remove a redirect after you are done using it:

8. Click on the redirect asset in the left asset tree, and then click the **More** tab, then click **Delete**.

9. Make sure the box is checked for “Un-publish Content”.

10. Click the **Delete** button. The file will be deleted from Cascade Server, and the redirect will be removed from your Web site.

### 26.2. Vanity URLs

A Vanity URL can be created as a shortened URL for use in marketing materials. For example, if you need to market a URL for applying to the college, that URL may be something like:

http://www.mycollege.edu/admissions/attend/apply-to-my-college.aspx. Instead of using that long URL, you should provide a much shorter URL in marketing materials, like http://www.mycollege.edu/apply.

#### 26.2.1. Add a Vanity URL

1. In the top navigation bar, click **+Add Content**, then **Redirect**, and then click **Vanity URL**.

2. In the “Folder Name” field, replace the value of “redirect” with the desired value. This value will be what shows just after your Web site domain name, shown as ‘apply’ in the following example:

   http://www.mycollege.edu/apply

A few tips on how to create this value:

- Keep it very short. The shorter it is, the easier it will be to fit onto marketing materials, and the easier it will be for a user to type in and remember.
  
  http://www.mycollege.edu/apply is more manageable than http://www.mycollege.edu/apply-to-my-college

- Do NOT use spaces.

- Do NOT use capital letters.

3. Click the **Submit** button. A new folder will be created in the left asset tree with the value you entered in Step 2 above.
4. In that new folder, click on the “default” page, then click the Edit link.

5. Select where you want the user to be taken when entering the vanity URL. You can link to a page within your Web site by using the “Link to Page” field, or link to a file within your Web site by using the “OR Link to File” field.

6. Click the Submit button. The file will be saved.

7. Publish the file.

8. Test your new vanity URL by entering into your browser: http://www.mycollege.edu/apply, where ‘apply’ should be replaced by the value that you entered in Step 2 above. You should be forwarded to the page or file you selected in Step 5 above.

26.2.2. Remove a Vanity URL

To remove a vanity URL after you are done using it:

1. Click on the vanity URL’s folder in the left asset tree, and then click the ...More link, then click Delete.

2. Make sure the box is checked for “Un-publish Content”.

3. Click the Delete button. The folder will be deleted from Cascade Server, and the vanity URL will be removed from your Web site.